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INTRODUCTION TO MEMORIES BUILDER 7 
 
 

What Does Memories Builder Do? 
Memories Builder™ is software for creating a presentation on a CD that can include 
images, video, audio, text, class portrait sections, and links to the Web.  
 
 

Customer Support 
If questions arise while using the software, don’t hesitate to call our technical support 
specialists. 
 
Telephone: (877) 463-6924 ext. 23 
Toll-free Monday - Friday between 7 am and 5 pm (PST)  
E-mail: techsupport@ybi.com 
 
 

mailto:techsupport@ybi.com
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Project Creation Principles – Please Read 
The following items will have a serious impact on your experience creating a yearbook. 
These items will help you avoid the most serious and catastrophic problems. These items 
are critical! 
 
• Do not delete your project prematurely. Keep your project and all related files 

(videos, images, and audio) on your computer’s hard drive until you receive the 
finished product back from us and have ensured that everything is the way you want 
it to be. Please inform your computer system administrators about this to keep them 
from deleting your files. 

• Follow all Finalize Project steps. It is critical that you follow the steps in the 
Finalize Project menu before sending your project to Yearbook Interactive. The most 
critical of these steps is called Export for Submission, which will put everything your 
project needs into a single file. This ensures that your project will have all of the 
necessary components when you send it. Please do not attempt to send project files 
before exporting. 

• Send a Final Submission Form. You must send a Final Submission Form with your 
project submission to Yearbook Interactive (see www.ybi.com/support.html to 
download the latest form). Projects that do not come with a completed Final 
Submission Form will be delayed until one is received. 

• Always exit the program. Always exit the program before logging off or turning off 
your computer to avoid corrupting your project. 

• Ensure adequate hard drive space. Memories Builder projects require large 
amounts of hard drive space. Check your computer for free hard drive space on a 
regular basis. If you run out of space while you are building your project, you may 
lose some of your work. 

• Keep the project under 600 MB. If the Space Indicator shows that the project is 
larger than 600 MB, it will not fit on a CD. Also, you will not be able to submit the 
project until it is small enough to fit on a CD. To reduce project size, determine what 
is taking up the space by choosing Compare to Plan from the Modify menu. The 
bottom of the dialog shows how much space video and audio files are taking up, as 
well as the number of pages in the project. To reduce project size, compress videos 
more or remove contents. Call technical support for more help at (877) 463-6924 ext. 
23. 

 

http://www.ybi.com/support.html
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Installation 
 
 
System Requirements 
Prior to installing Memories Builder, ensure that your computer meets the following 
technical specifications: 

Windows: 
• Windows 2000 or XP 
• Pentium® 4 1.6 GHz or comparable AMD Athlon processor 
• 256 MB RAM (512 MB recommended) 
• 16 MB Video RAM (64 MB recommended) 
• Available Hard Disk Space: at least 1 GB 
• CD Burner 

Macintosh: 
• OS X 10.2.6 or greater 
• G3 600 MHz or Faster (1 GHz recommended) 
• 256 MB RAM (512 MB recommended) 
• 16 MB Video RAM (64 MB recommended) 
• Available Hard Disk Space: at least 1 GB 
• Power Mac G3, G4, G4 Cube; iMac; PowerBook G3, G4; iBook; or eMac with CD 

burner 

Software Requirements: 
• QuickTime is required. (Available on the Memories Builder disc or at 

www.quicktime.com.) 
• Java 1.4.2 is required for the PC. (Will be installed with the Memories Builder 

software.) 

System Settings 
• Monitor Resolution: 1024 x 768 or higher 
• PC Color Depth: High Color-16 bit. (True Color-32 bit recommended) 
• Mac Color Depth: Millions of Colors 

Recommended Additional Equipment 
• Speakers 
• Digital Camera 
• Photo Editing Software (e.g. Photoshop) 
• A microphone compatible with your specific computer 
• Digital Camcorder 
• Movie Editing Software (e.g. iMovie, Adobe Premier, Muvee) 
• Audio Editing Software (e.g. Audacity, Bias PEAK, Sound Forge) 
• Scanner

http://www.quicktime.com/
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Installing Memories Builder on a PC 
1. Insert the Memories Builder 7.0 disk into the CD-ROM drive of your computer. 
2. The disc is programmed to auto run and will automatically launch a menu.  

Note: If the disk does not automatically run, locate the CD from My Computer. Click with the 
right mouse button on the CD drive, and select Explore from the menu that pops up. In the 
new browse window, double-click on Menu.exe.  

3. Click on the first menu item, Install Memories Builder 7.0. If installation does not 
begin, call technical support at (877) 463-6924 ext. 23. 

4. Allow the installation to keep the default settings and locations. If you need to do a 
custom installation, read each step carefully. 

5. When the installation is completed, the CD will check to make sure you have a recent 
version of QuickTime installed on your computer. If you don’t, follow the 
instructions to install it. 

6. When installation has finished, close all installation windows. 
7. The Memories Builder 7.0 CD menu also includes the following options (if the menu 

is no longer open, eject the Memories Builder CD from your CD-ROM drive and re-
insert it): 
• User’s Guide—Opens this document, which contains instructions on how to use 

the many features of Memories Builder 7.  
• Visit Our Web Site—Visit our Web site at www.yearbookinteractive.com for 

information, updates, support, downloads, and more. 
• Install Acrobat Reader—Installs Acrobat Reader, the program required to view 

documents in .pdf format, such as the User’s Guide. 
 
 
Installing Memories Builder on a Macintosh 
1. Insert the Memories Builder 7.0 disc into the CD-ROM drive of your computer. 
2. Double-click on the CD-ROM image on your desktop to view its contents. 
3. Double-click the menu icon (Double-Click to Start).  
4. Click on the first menu item, Install Memories Builder 7.0. If installation does not 

begin, call technical support at (877) 463-6924 ext. 23. 
5. Allow the installation to keep the default settings and locations. If you need to do a 

custom installation, read each step carefully. 
6. When installation has finished, close all installation windows. 
7. The Memories Builder 7.0 CD menu also includes the following options (if the menu 

is no longer open, eject the Memories Builder CD from your CD-ROM drive and re-
insert it): 
• User’s Guide—Opens this document, which contains instructions on how to use 

the many features of Memories Builder 7.  
• Visit Our Web Site—Visit our Web site at www.yearbookinteractive.com for 

information, updates, support, downloads, and more. 

http://www.yearbookinteractive.com/
http://www.yearbookinteractive.com/
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Updating Memories Builder 
Yearbook Interactive is always seeking to improve Memories Builder, and will 
occasionally release updates to the program with enhanced features and fixes.  
 
We strongly recommend that you install updates to Memories Builder as they become 
available. To update Memories Builder, choose Check for Updates from the Help menu 
or visit the Yearbook Interactive website (www.yearbookinteractive.com) and click on 
Updates, where you will find update files and instructions. 
 
If you do not have access to the Internet, you may request product updates by calling 
Tech Support at (877) 463-6924 ext. 23. 

http://www.yearbookinteractive.com/
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USING MEMORIES BUILDER 7.0 
Note on appropriate permissions:   
Your Yearbook Interactive project will contain text, images, audio and video, some of 
which will be subject to copyright protection.  It is the responsibility of the school to 
secure any permission necessary to reproduce stories, images, audio and video 
recordings.  For more information on copyright, see the U.S. Copyright Office website at 
www.copyright.gov. 
 
 

Quick Overview 
• The Master Level contains the top-level 

sections and may also have a Master 
Overlay.  

• Sections are dividers for organizing the 
project. Also, background images and 
music are associated with the section 
and appear on every page in the section 
(they can be suppressed for specific 
pages by double-clicking on the page name). 

• Pages are what the viewer sees. They contain objects, such as images, movie files, 
shapes, and text. 

• Overlays allow you to place images, shapes, or text on every page in the project 
(Master Overlay) or section (Section Overlay). To enable an overlay for a section or 
the Master Level, choose Section Properties or Project Properties from the Modify 
menu and check the appropriate box. 

• Objects are items that you place or create on pages, such as images, text, video, 
audio, shapes, and Hot Spots. 
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Becoming Familiar with the Project Workspace 
Memories Builder makes building a CD presentation easy. Understanding the workspace is the 
key. 
 
The project workspace consists of 8 major elements: 

 
1. Menu Bar—Most application functions can be accessed through this area. 
2. Main Toolbar—The most commonly used project or page functions can be accessed here. 
3. Contents Toolbar—Page and section functions can be accessed on this toolbar. 
4. Contents Window—Displays the project structure (tree), including the Master Level, 

sections, overlays, and pages, as well as their status (enabled or disabled). 
5. Canvas—Master Overlay, Section, and Page objects are displayed in this area. The Canvas 

is where you will create the multimedia presentation by adding images, text, audio, and Hot 
Spots (see p. 31) to the Sections, Subsections, Pages, and Overlays. It is 800 pixels wide by 
600 pixels high. 

6. Space Used Indicator Bar—Visual indicator of the amount of space available to allow the 
project to fit on a CD (green indicates the space used, red indicates the project is too big). 

7. The Frame Adjustment Bar—Allows control over the amount of space used for the 
Contents window or the Canvas. 

8. Pop-up Navigation Area—The final presentation will include a bar that has navigation 
buttons similar to a Web browser. Warning: Hot Spots and video placed in this area may 
interfere with the ability to access pages. Preview the project to check for problems. 
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Project Structure 
The Project Structure portion of this User’s Guide will instruct you on the basic steps for 
beginning your Memories Builder project, organizing it, and preparing it for objects. 
 
Creating a New Project 
The first step in starting a CD yearbook project is to create a new project. This process 
will also allow you to choose where to save the project and what to name it. 
1. The first time you open Memories Builder, it will prompt you to create a new project. 

You may also create a new project at any time by clicking on the Create Project 
icon or choosing New Project from the File menu. 

 
2. In the New Project Dialog:  

• Type in a Project Filename (e.g. Legacy 
Elementary School). When Memories Builder 
creates your project, this will be the name of the 
project folder. You will not be able to create two 
projects with the same name in the same folder. 

• Click on the open folder icon to choose a location 
for your project or make a note of the default location.  

• Click on a folder in the Open dialog and click the Select Folder button. 
• When you have made your choices, click on the OK button. 
 

3. The New Project Information box appears. Please provide the following:  
• School Name, Yearbook Title, School Year 

– These items appear on a screen that 
displays while the final presentation is 
loading. 

• Preview – Click on this button to see what 
the splash screen for the final presentation 
will look like. 

• Introduction Video (Optional) – Check the 
box to include a video that plays before the 
regular presentation. Click on the open 
folder icon to browse for the video file to 
use as an introduction. 

• Select a Master Border – The selection box 
in the lower left side of the dialog allows 
you to choose a Master Border. A Master 
Border is a design element such as a border 
or graphic that shows up on every page of 
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the project to provide consistency and visual interest. Click on a Master Border 
in the list, and the preview will appear in the window to the right. To learn how 
to create your own Master Border, see p. 54. 

• Primary and Secondary Colors – Some of the Master Borders change colors 
based on your selections for the Primary Color and Secondary Color. For more 
choices, click on the More Colors button. This brings up the Choose School 
Color dialog box, which is essentially the same as the Font Color Chooser dialog 
(for more information, see Color Chooser on p. 26).   

• Master Overlay – Adding a Master Overlay to your project will allow you to 
place objects on every page of your presentation, such as a project title (see 
Master Overlay on p. 52). 

4. Click OK when you have made all of your selections. 
 
Part II: Planning 
Memories Builder will ask you whether you would like to plan the project. There are a 
few steps to planning the project: 
• Multiple User Information 
• Select and name sections 
• Assign sections and deadlines, estimate contents 
• Project plan summary (with option to print) 

Note: You may view, change, or fill in a project plan at any time, even if you decide not to 
plan at this point, by choosing Plan Project from the Modify menu. 

1. Click on the Plan button to begin the planning process. To begin work immediately, 
click on No Plan and proceed to CD Yearbook Content Folders (p. 15).  

 
Multiple Users 
If you choose to plan at this point, Memories Builder will ask you whether you will 
be working on more than one computer or project (and then combining them at the 
end). 

2. Click on the Yes button if you will be combing multiple projects at some point. 
Otherwise, click on the No button and proceed to Sections below. 
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3. The next prompt asks whether this will be the Master Project. When you combine all 
of your projects, the project into which you combine them all is considered the 
Master Project. Click on the Yes button if this will be the Master Project. Otherwise, 
click No. 

 
Sections 
The next part of the planning process helps you create your project’s sections. 
Sections contain the pages of the project. 

4. Choose a school type by clicking on the drop-down menu and then clicking OK. 

 
5. Now the Project Planning window will appear. 

a. Select the sections the project will 
include by checking the boxes next 
to the section names.  

b. Click on the plus symbols (arrow 
symbols on the Mac) to expand the 
section structure. 

c. To add custom sections, click on the 
Add Section button. In the Add 
Section dialog, type in a section 
name. The section will be created as 
a subsection of the currently 
selected section unless you check 
the Create on main level checkbox. 

d. The Select All, Select None, Select 
All In Section, and Clear All In 
Section buttons are there to help 
you choose your sections more quickly or clear everything out. As a precaution, 
the Class Portraits section cannot be removed. Since there is no way to create a 
portrait section from the New Section action, the locked Class Portraits section 
insures that you will always be able to have a portraits section. If you choose to 
not include portraits in your project, disable the Class Portraits section, and it will 
be removed from the presentation when you finalize your project. 
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e. When you have finished, click on the Next button. 

6. The next screen prompts you to choose the date you need to receive your project 
back from Yearbook Interactive. Click on the drop-down menus to select the date. 
This screen will show you other deadlines related to your project. Click Next. 

 
7. The next screen is for assigning portions of the project to students and setting 

deadlines and expectations for sections. 

 
a. Fill in the Assigned to and Deadline fields for each section. Navigate through the 

sections by clicking on the blue arrows (PREV and NEXT). 
b. Approximate how many pages each section will have, as well as the amount and 

type of audio and video you will use. Memories Builder will estimate how much 
space each section will take. 

c. You may add sections by clicking twice on the Back button.  
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d. When you have finished all of your assignments, click Finish. 

8. The final screen shows you a summary of the Project Plan. There are a number of 
informative reports you can print. Choose the type of report and click on Print 
Report to print the Project Plan summary.  

Project Report Types: 
Section – This report presents a summary of the project plan with the information 
organized by section. 
Assigned To – Shows the project plan information for every section that has been 
assigned, grouped according to assignment. 
Deadline – This report organizes deadlines chronologically. Useful for keeping track 
of which project and section deadlines are approaching. 
Assignment Pages – Prints a planning and deadline sheet for each person who is 
assigned a section of the project. Useful for handing out to students. 

9. Click Finish to exit the Project Plan.  

 
CD Yearbook Content Folders 
As a final option when creating a new project, Memories Builder can create folders 
to hold the images, audio, and video you will use in the project. The folders will be 
created with the same structure as your project. 

10. To create these folders, click Continue. Memories Builder will prompt you to select 
a location for the folders. Click Skip if you do not wish to create the folders. 
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11. After creating contents folders or choosing to skip creating contents folders, 
Memories Builder will create your new project.  

12. As Memories Builder creates your new project, it will prompt you to create a page 
and to set section properties. For more information on these items, see Add a Page 
(below) and the section properties description in #3 of Add a Section on p. 17. 

 
Opening a Memories Builder Project 
To open and begin working on an existing project: 
1. Choose Open Project from the File menu. 
2. Browse to the location of the project and click once on the project folder to select it. 

Click on the Select Project button.  
Please note that you are browsing for a folder, not a file. Also note that you will be 
unable to open a project by double-clicking on a project’s folder or files outside of 
Memories Builder. 

 
Add a Page 
Memories Builder pages are like pages in a print yearbook – they hold all of the content, 
including images, movie files, captions, and more. Memories Builder provides the option 
of using a template or creating a custom layout by starting with a blank page. 
1. In the Contents window (left side of the program), select a section. 
2. Either click on the New Page icon, or choose New Page from the Insert menu. 

  
3. Choose a blank page or a page template in the Select Page Template dialog. The 

number in the page template name represents the number of images in the template. 
In the preview pane on the right side of the Select Page Template dialog, blue boxes 
represent image areas, while yellow boxes represent text areas. 
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4. Click OK. If this is the first page in a section, Memories Builder will prompt you to 
set the section options. For more information, see the section properties description in 
#3 of Add a Section (below). 

 
Add a Section 
Sections help organize the presentation. Background images and music are section 
properties, meaning that a background image will display on every page in a section and 
background music will play on every page in a section.  
1. In the Contents window, select the Master Level to add the section at the top level, or 

select a section to create a subsection. 

 
2. Click on the Add Section icon or choose New Section from the Insert menu. 

 
3. The Section Properties box appears. 

a. Section Name – Assign 
a name to the new 
section. 

b. Section Enabled – If 
this box is checked, the 
section will appear in 
the final presentation. 
To disable the section 
without deleting it, 
uncheck the box. 

c. Overlay Options – 
Allows you to add an 
overlay to this section 
and determine whether 
other overlay objects 
appear in this section or 
not. 

d. Background Image – 
This provides a design 
backdrop for the 
images and text on the 
pages, and gives the 
project a professional 
look. Click on the 
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folder icon to browse and preview the background images that Memories Builder 
provides. Reducing the opacity (lower percentages) will make it easier to read 
text on the pages in the section. To design or import a custom background, see 
Create a Custom Background Image on p. 57. 

e. Transition – A transition smoothes the change between pages and adds a nice 
visual effect. Click on the down arrow to choose a transition style for the section. 
To see what the transition looks like, enter Preview mode by clicking on the 
Preview icon (the section must have at least two pages). 

f. Background Audio – Background music adds to the energy and personality of the 
project. Memories Builder supports a number of different audio file formats: 
WAV, MP3, AIFF, AU, MIDI, and System 7 sounds. The Memories Builder 
Music Library icon  will take you to the music selections that come with 
Memories Builder. To choose a custom background audio file, click on the plain 
yellow folder icon to browse for your file. Choosing Loop will cause the audio to 
continue playing until viewers reach the next music selection. For more 
information about the Play None option, see Organizing Sounds and Music on p. 
59. 

 
Rename a Page 
Not only will page names help organize a project, they will also show up when a viewer 
clicks on the Table of Contents icon in the final product.  
1. Locate the page in question in the 

Contents window and double-click 
on it. 

2. In the Page Properties dialog, 
select the current name, delete it, 
and type in a new name (or just type over it). 

3. Click OK. 

 
Rename a Section 
Section Names help to organize sections of the project. They will appear in the final 
presentation when students click on the Table of Contents icon.  
1. To rename a section, double-click its green folder icon in the Contents window.  

2. In the Section Properties dialog, select the current name, delete it, and type in a new 
name (or just type over it). 

 
3. Click OK. 
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Move a Page 
The process for moving a page to a different section is the same as reordering pages 
within a section. 
1. Locate the page to move in the Contents window. 
2. Click on the page name and hold down the mouse button. 
3. Drag the page to its new location (a light gray line will show where the page is 

moving) and release the mouse button. 

 
Note: To move a page to another section, expand the destination section in the Contents 
window by clicking on the plus symbol next to the section name. 

4. To move a page to a section that currently has no pages, drag it over the section 
diamond and move the mouse to the right until the down-pointing arrow appears and 
then release. 

 
5. To move several pages that are in the same section, follow these instructions: 

Windows Computers: Hold down the Ctrl key and click on pages to select them. 
Then right-click and choose Move To from the pop-up menu. A new window 
appears with the contents of the project. Click on the section to place the pages in. 
Click OK. 

Mac Computers: Click on the first page to move. Hold down the Apple key and click 
on more pages to select them. Hold down the Apple and Control keys simultaneously 
and click on the last page to move. A menu appears. Choose Move To from the pop-
up menu. A new window appears with the contents of the project. Click on the 
section to place the pages in. Click OK. 

 
Move a Section 
Memories Builder allows flexibility in organizing the CD supplement. To move a section 
or subsection:  
1. Locate the section to move in the Contents window. 
2. Click on the section name and hold down the mouse button. 
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3. Drag the section to its new location and release the mouse button. A light gray line 
will show where the section is moving. 

 
Note: To group sections into subsections, take each section and drag it over the name of the 
parent section until a down-pointing arrow appears to the left of the mouse pointer.  

 
 
Disable/Enable a Page or Section 
To deactivate a page or section in the project without deleting it: 
1. Double-click on the page or section in the Contents window. 
2. In the Properties dialog box, uncheck the Page Enabled or Section Enabled 

checkbox. 

 
3. Click OK. 

To enable a page or section that is disabled: 
1. Double-click the page or section in the Contents window. 
2. In the Properties dialog box, check the Page Enabled or Section Enabled box. 
3. Click OK. 
 
Delete a Page or Section 
To remove a page or entire section from the project: 
1. Locate the page or section in the Contents window. 
2. Select the page or section by clicking once on it. 
3. Either click on the Delete icon on the toolbar or right click the mouse (Ctrl-click on 

the Mac) and select Delete. 
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4. Confirm deletion of the page or section in the message box that pops up by clicking 
OK. 

 
Preview the Project 
Previewing is the best way to check the progress of the project. Preview mode simulates 
the final presentation. It has all of the functionality of a final presentation, including 
background music, navigation buttons, etc. 
1. Click on the Preview icon on the toolbar or choose Preview from the File menu. 

 
2. Memories Builder will go into Preview mode. Moving the mouse near the bottom of 

the presentation brings up a row of navigation and function buttons. 

3. Passing the mouse over the navigation and function buttons will pop up a tool tip that 
explains what each button does. Use the next and previous arrows to move through 
the presentation. 

 
Note: For a high quality presentation, preview frequently. Use the guidelines in the Project 
Completion Checklist (See Appendix G on p. 93). 

 
Compare Project to Plan 
Choosing Compare to Plan from the Modify menu brings up a new dialog with a side 
by side comparison of the project plan and the project’s current contents, including 
number of pages, size of video files, size of audio files, and total section size, as well as 
deadlines and assignments for the section. 
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Page Objects 
A Page Object is anything that you place on a page, such as images, text, links to files 
and pages, etc. All of these objects can be manipulated on the canvas with cut, copy, 
paste, and move operations. 
 
Selecting Objects 
In order to move or modify objects that you place on the page (images, text, video clips, 
etc.), you will need to select the object first. To select an object, click on it once.  

You can select multiple objects by holding down the mouse button and dragging a 
selection rectangle over the objects you would like to select or by holding down the Shift 
key as you click on objects. 

 
You may also use the drag method for selecting a single object. 
 
Cut, Copy, and Paste 
Memories Builder’s Cut, Copy, and Paste functions help students edit pages by moving 
graphics, photos or text to different pages. These functions are also useful for placing the 
same images or text on several pages.  

Cut 
1. Click on the object(s) to be cut. 
2. Select the Cut icon  or choose Cut from the Edit menu. 
3. The cut object(s) is now available for pasting anywhere in the project. 

Copy 
1. Select the object(s) to be copied by clicking on it. 

2. Select the Copy icon  or choose Copy from the Edit menu. 
3. The copied object(s) is now available for pasting anywhere in your project. 

Paste 
1. After cutting or copying an object, select the page in the Contents window where the 

object(s) should be pasted. 
2. Either click on the Paste icon  or choose Paste from the Edit menu. 
3. The object(s) will be placed on the canvas slightly offset from the original position of 

the cut or copied object(s).  
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Note: After the initial offset paste, all subsequent pasted objects will paste right on top of 
each other.  

 
4. Alternately, click on the Paste in Place icon  to paste the object without an offset. 
 
Move and Align Objects 
To move objects:  
1. Select the object to move by clicking on it and holding the mouse button down.  
2. While holding the mouse button and dragging, the object may be placed anywhere on 

the page. A light gray outline of the object will move around the page to assist in 
placing the object. 

3. The process for moving multiple objects simultaneously is the same. Simply select 
objects by clicking on them while holding down the Shift key. You may also select 
all objects on a page by choosing Select All from the Edit menu. Then proceed 
moving the objects as you would a single object. 

 

Canvas Grid 
To ensure accuracy when aligning objects, an underlay grid can be placed on the Canvas. 
Click on the grid icon to display the grid. 

 
 
Another way to align objects on the canvas is with the Align menu item. The first six 
options align selected objects in reference to one another. The last two align objects with 
respect to the canvas. 
1. After selecting one or more objects, choose Align from the Modify menu (also 

available from the right click menu). 
2. The submenu pops out. Choose from the listed options. Available alignments: 

• Top – Aligns all selected objects to the topmost object on the canvas. 
• Middle – Lines up the vertical middle of each selected object. 
• Bottom – Aligns all selected objects to the bottommost object on the canvas. 
• Left – Aligns all selected objects to the leftmost object on the canvas. 
• Center – Lines up the horizontal center of each selected object. 
• Right – Aligns all selected objects to the rightmost object on the canvas. 
• Center Vertical – Places all selected objects in the vertical center of the canvas. 
• Center Horizontal – Places all selected objects in the horizontal center of the 

canvas. 
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Delete Objects 
Memories Builder provides a number of ways to remove objects from the project. 
1. Select the object by clicking on it. 
2. Do one of the following: 

• Choose Delete Object from the Modify menu. 
• Click on the Cut icon.  
• Choose Cut from the Edit menu. 
• Hit the Delete key on your keyboard. 
• Click on the object with the right mouse button (Ctrl-click on the Mac) and 

choose Delete from the menu that appears. 
 
Add Images 
Images such as pictures are a major component of the CD multimedia presentation.  
Note: To preserve transparency in images, save the image in PNG format from your image 
editor. 

Template Images 
1. To add an image on a template page, double-click on a blue image box. 
2. Browse to the image file, and click Open. 
3. The image will appear in the Image Editor.  

 
• The grayed-out portions of the image will not appear on the page.  
• The Reset button will undo any changes you make in the editor.  
• The next set of buttons will rotate the image 90º counter-clockwise (left button) 

or clockwise (right button).  
• The magnifying glass icons will adjust the cropping of the image to include more 

(left button) or less (right button) of the image.  
• To change which portion of the image is displayed, click on the image and hold 

the button down while dragging the mouse around.  
• Click OK to place the image. 
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4. The image replaces the blue box on the page. 
5. To move the image, click on it and hold the mouse button down while dragging the 

image to its new location. To resize the image, drag one of the gray boxes around the 
edge of the image. 

Non-Template Images 
Place an image anywhere on the canvas and make it any size with this method. 
1. Click on the Image icon or select Add Image from the Insert menu. 

 
2. Browse to the image in the File Preview dialog, select the image, and click Open. 

 
3. Position the crosshair to place the image on the page. 

Click once on the page to place the full-sized image, or 
click and hold the mouse button down and drag the 
mouse to open up a placement rectangle, as shown at 
right. Memories Builder will display the dimensions of 
the placement rectangle on the bottom right bar (next to 
the Space Indicator) as you drag. 

4. After releasing the mouse button, Memories Builder will place the image. To learn 
how to edit images after placement, see Edit Images on p. 33. 

Image Borders and Shapes 
To add an image with a border or a particular shape (see example below), add a shape 
first and fill the shape with the image. See Add Shapes for more information (p. 32). 
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Add Text 
General Suggestion: Ensure that there is enough contrast between the text and the 
background image so that text is easily readable. Choose a text color that stands out 
and/or add a text shadow to make text easier to read. 

To add captions, titles, or stories:  
1. Click on the Text icon or choose Add Text from the Insert menu. 

 
2. The Font Style Chooser dialog will pop up. It provides a number of options for the 

text. 
a. Font face – a set of printable or 

displayable text characters in a 
specific style. 

b. Font size – determines how large 
the characters are. Choose from the 
list or type in a number. 

c. Font style – allows emphasis of 
words using bold, underline or 
italic styles. 

d. Font alignment – determines the 
justification of the text inside the 
text box. 

e. Font color – changes the text color 
for the selected words or characters. 
Click on a color on the color palette 
or click on More Colors… to open 
the Font Color Chooser (see Color Chooser below for more information). 

f. Preview box – shows how the text will appear on the page. 

3. Type text in the text preview area. To change style elements after typing in the text, 
highlight the portion of the text to change (any portion may be selected and changed 
independently of the rest of the text) and choose the style change. 

4. Click OK when finished. 
5. When returning to the page, click and hold the mouse button down and drag the 

mouse to open up a placement rectangle. The text appears in a box that can be moved 
or resized like any other object. The text tool bar above the page canvas provides 
access to a number of text functions (see Edit Text on p. 36). 

 
Color Chooser 
A number of functions provide advanced color choices through Memories Builder’s 
Color Chooser. See the instructions below for accessing the Color Chooser. 
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Text 
• Method 1: Double-click on the text on the page canvas. In the Font Style Chooser 

dialog, highlight the text. Click on the More Colors button. 
• Method 2: Select a text box. Click on the Text Color icon from Text Tools. Choose 

More…. 

Shapes 
Click on the shape on the page canvas. The Shape Tools give you the option of changing 
the color of the border or fill. Click on one of the color icons and choose More…. 

Portrait Names 
Choose a portrait section in the Contents window. Choose Portrait Page Template and 
Name Settings from the Portraits menu. Click on the More Colors button. 
 
1. The easiest way to select colors is to click on one of the color squares on the 

Swatches tab. For this or any other method of choosing colors, the Preview window 
will show the chosen color. 

 
2. To custom select a color or choose a color that is not available in the swatches, click 

on the HSB or RGB tab. 
 

HSB (short for Hue, Saturation, 
Brightness) is useful for adding or 
removing white, black, and gray in the 
color, as well as lightening and 
darkening a color.  
• Move the slider next to the color 

bar up and down to choose the 
desired hue or type it into the H 
field.  

• Click on the circle in the large 
color box and drag it around to add 
or remove white, black, and gray.  

• The Reset button returns to the 
original color selection. 
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RGB (short for Red, Green, Blue) is a standard 
method of choosing colors.  
• Move each slider bar back and forth to add or 

reduce the amount of each color in the 
composite color.  

• An absence of the color is 0, while 255 
represents the maximum amount of that color. 

 
3. After selecting the desired color, click OK. 

 
Add Video 
Memories Builder uses video clips in two manners: directly on the Canvas or as a link 
(see Add Hot Spots on p. 31). Placing a movie on the Canvas will allow viewers to play 
the movie directly on a page. Adding a video clip as a link will open a new window to 
play the clip. 
Important: Do not attempt to place video files on or below the Pop-up Navigation Area. 
Viewers will be unable to access any navigation bar buttons that the video covers up, and 
may be unable to properly view the project. 
 
Memories Builder 7 can accept the following formats: QuickTime movie (.mov), AVI 
(using Cinepak, DV, or Motion JPEG codecs), MPEG (.mpg), and Flash (.swf) files.  
 
1. Click on the Movie icon or choose Add Movie from the Insert menu. 

 
2. Browse to the correct file in the File Preview dialog. Preview the movie by clicking 

on the play button in the preview pane on the left. 
3. Double-click on the video file in the File Preview dialog or select the file and click 

Open. 
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4. The cursor will change to a corner bracket. Click on the canvas to place the video.  
5. If your movie file is an uncompressed file (e.g. straight from a digital camera or 

camcorder) or if it is insufficiently compressed, Memories Builder will start the 
Export Settings process unless you are using a Mac OS 10.2 computer (in that case, 
call Tech Support for suggestions). Click on the OK button to begin. If you do not 
see this dialog, Memories Builder will place the video immediately. Skip to step 19 
on p. 31. 

 
6. In the Movie Settings screen you will have 3 sections: Video, Sound, and Prepare for 

Internet Streaming. 
7. Click on the Settings button in the Video area. 

 
8. The Compression Settings box opens. 
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9. Set the following options: 
• Choose MPEG-4 Video from the top pull-down menu. 
• Drag the Quality slider to Best. 
• Frames per second set to Best. 
• Key frame every 24 frames. 
• Limit data rate to 90 to 150 Kbytes/sec (the lower range for interviews and less 

motion, higher range for action and sports). 
10. Click OK. You will be returned to the Movie Settings screen. 
11. In the Video section click the Size button. The Export Size Settings box opens. 

 
12. Set the following options: 

• Choose Use custom size. 
• Set Width to 320 (if people look too thin, try 360). 
• Set Height to 240. 

13. Click OK. You will be returned to the Movie Settings screen. 
14. In the Sound section click the Settings button. The Sound Settings box opens. 

 
15. Set the following options: 

• Choose None from the Compressor pull-down menu. 
• Rate: 22.050 kHz. 
• Size: 16 bit. 
• Use: Mono. 

16. Click OK. You will be returned to the Movie Settings screen. 
17. In the Prepare for Internet Streaming section, make sure that the box is NOT 

checked. 
18. Click OK. Memories Builder will compress the video and then place it on the canvas. 
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19. To move the file position on the page after placing it, just click and drag. 

 
 
Add Hot Spots (Add Links to Files) 
Hot Spots make the project interactive. A Hot Spot is an area on a page that viewers can 
click to open a file (text, movie, audio), jump to another page in the CD presentation, or 
link to a Web page.  

Important: Avoid putting Hot Spots in the area below the Pop-up Navigation Area. 
Navigation bar buttons will take priority, making the Hot Spot unusable. 
1. Click on the Hot Spot icon or choose Add Hot Spot from the Insert menu. 

 
2. The Link Hotspot To dialog box will appear. 

Select the type of link to create – Web, 
Audio, Movie, File, or Yearbook Page. 
a. To link to a Web page, select Web and 

type the Web address in the Web field. 
b. For Audio, Movie or another File, select 

the appropriate radio button and browse 
to the file by clicking on the open folder 
icon.  

c. To link to another page in the yearbook, 
select Yearbook Page. Memories 
Builder displays a structure of the 
project similar to the Contents window. 
Click on the plus symbols (arrow icons 
on the Mac) to open sections, and then 
click on the name of a page to link to it.  
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Note: Linking to Class Portraits pages is not allowed because of the dynamic nature of 
portrait pages (every change to a portrait page would break the link). 

d. The Tool Tip box displays a description of the link when the viewer holds the 
mouse over the link in the final presentation (see example below). 

 
e. When you have finished setting up the Hot Spot, click OK. 

3. Click and drag the mouse to create a rectangle on the page where the Hot Spot will 
appear. This defines the active area where viewers will click. 

 
4. The Hot Spot area may be resized by clicking and then dragging one of the semi-

transparent rectangles on the border of the Hot Spot rectangle.  
5. To prevent Hot Spots from getting lost on a page, they are always on the top layer. If 

you need to select an object on a layer underneath a Hot Spot, temporarily move the 
Hot Spot out of the way, modify the other object, and then replace the Hot Spot. 

Tip: Be careful when linking to files created in a program that may not be on every 
computer, such as WordPerfect or Windows Media Player. Save files in generic formats, 
(for example, .rtf or .wav) to accommodate everyone. 
 
Add Shapes 
Shapes can be used as design elements in a number of ways. Shapes behind text can 
make the text stand out, or various odd shapes can make the page more fun. Shapes can 
also act as a border for an image. 
1. To add a shape to the page canvas, click on the Shape icon. 

 
2. Choose a basic shape from the drop-down menu. 
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3. Click on the page canvas and hold the mouse button down as 
you drag open an area to define the size and placement of the 
shape (as shown at right). Release the mouse button. 
Memories Builder will draw the shape. 

4. Click and hold on any of the gray squares at the edges of the 
shape while dragging the mouse around to resize a shape. 

5. See Edit Shapes on p. 38 for information on modifying the 
shape. 

 
Edit Images 
With Memories Builder students can modify images in a number of ways using the Image 
Tools. When you click on an image, the Image Tools will appear immediately above the 
Canvas. Selecting an image on a page brings up the following tool icons just above the 
workspace: 

Image Tools 

 

Icon Descriptions: 

1. Zoom 
Click on the left button to increase the size of the image on the canvas. Click on the right 
button to reduce the size of the image on the canvas. 

2. Orientation 
This feature makes it easy to correct images that were taken in different orientations 
(portrait and landscape) so that everything is right side up. The left button rotates the 
image 90° counter-clockwise, and the right button rotates it 90° clockwise. 

3. Rotate 
Click on this icon to rotate images by degrees. Drag the slider to the right to rotate the 
image clockwise or left to rotate it counter-clockwise by the number of degrees indicated 
on the slider. You may also type the number of degrees to rotate the image in the text 
field near the bottom (this feature does not work for Mac OS 10.2). Positive numbers 
rotate the image clockwise and negative numbers rotate it counter-clockwise. 

 



 Memories Builder 7—User’s Guide 

 

34 

4. Crop 
Use this tool to select desired parts of an image. 

a. Click on the Crop icon.  
b. In the crop window, click on the image and hold the mouse 

button down while dragging to define an area of the photo or 
graphic to use. 

c. The cropped area may be moved around for the best editing by 
clicking inside the selected area, holding the mouse button 
down, and moving the crop marked area to the desired portion 
of the image.  

d. Clicking on the light gray box in the bottom right corner of the 
crop region and dragging the mouse will enlarge or reduce the region and change its 
shape. 

e. To clear out your crop region selection, click on the Cancel button. 
f. When satisfied with the crop selection, click on the Accept button in the crop 

window. 

5. Image Effects  
Click on this drop-down menu to select an effect for the selected image.  

Sharpen – Increases the focus or definition of the image. 
Blur – Softens the focus or reduces the definition of the image. 
Negative – Reverses the color of the image. 
Darken – Moves the balance of light and dark shades in the image more toward the 

dark shades. 
Brighten – Moves the balance of light and dark shades in the image more toward the 

light shades. 
Gamma Correction – Changes brightness values of the middle range of gray tones 

without dramatically altering the shadows and highlights. 
Emboss – Makes the image look like foil has been placed over the image and it has 

been sculpted to the image’s contours and colorized. 
Sketch – Simulates a drawing of the image (black and white). 
Black/White – Transforms a color image into a black and white image. 
Fish Eye – Simulates viewing the image through a fisheye lens, a lens that distorts 

the image to make the middle portion of the image appear larger and the outer 
edges smaller. 

Impressionist Painting – Gives the image an artistic brushed look. 
Mirror – Turns the image around, as if you were seeing it in a mirror. 
Flip – Turns the image upside down. 
Sepia – Applies a brown and white coloration to the image like early 20th century 

photographs. 
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6. Opacity Slider   
This image property allows you to make images semi-transparent (the original state of the 
image is 100% opaque – not transparent at all). The percentage you choose will 
determine how transparent or opaque the image is (the lower the percentage, the more 
transparent). You may also type an opacity percentage into the text field near the bottom 
of the Opacity dialog (this feature does not work for Mac OS 10.2). 

 

7. Shadow 
Click on this icon to bring up a dialog in which you may add a shadow to an image or 
edit an existing shadow. A shadow makes the image stand out and to give it a sense of 
depth on the canvas. 
In the Shadow Properties dialog: 
• Use the Opacity slider to affect how 

deep or light the shadow is. 
• Use the Blur slider to increase or 

decrease the sharpness of the 
shadow’s edge. 

• Click on the Color box to choose 
what color the shadow will be. 

• Click on the shadow in the area to 
the top right and hold the mouse 
button while dragging to move the 
shadow around. You may also use 
the arrow keys on the keyboard to 
nudge the shadow. 

• Ensure that the Enable Shadow box 
is checked (uncheck the box to 
remove the shadow). 

• Click OK to place the shadow. 
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Edit Text 
The Text Tools allow you to modify text in a number of ways, including rotation, 
transparency, fills, and borders. Selecting text on a page brings up the following tool 
icons just above the workspace: 

 
Note: If you are unable to see all of these icons, click off of the text box, drag the Frame 
Adjustment bar (the bar in between the Canvas and the Contents window) to the left, and select 
the text again. 

Icon Descriptions: 
1. Font – Changes the font (a set of printable or displayable text characters in a specific 

style) in the text box. 
2. Size – Changes the size of the text (larger numbers correspond with larger text). 
3. Style Buttons – Emphasize words or characters using bold (B icon), italic (I icon), or 

underline (U icon) styles. 
4. Alignment Buttons – Determines the justification of the text inside the text box (left, 

center, or right alignment). 
5. Color – Use this button to change the color of the text or choose an image to fill the 

text. 
6. Edit Image Fill – After filling the text with an image, click on this button to choose 

the portion of the image to use as a text fill or replace the current text fill image with 
a different image. 

 
• Use the Zoom buttons to use a larger or smaller portion of the image in the text. 
• Click on the Replace Image button to choose another image to fill the text. 
• Click on the Reset button to return the image to its original state. 
• Click on the image and hold the mouse button down as you drag to move the 

image around. 
• Click OK to accept the changes. 

7. Opacity – This text property allows you to make text semi-transparent (the original 
state of the text is 100% opaque – not transparent at all). The percentage you choose 
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will determine how transparent or opaque the text is (the lower the percentage, the 
more transparent). You may also type an opacity percentage into the field near the 
bottom of the Opacity dialog (this feature does not work for Mac OS 10.2). 

 
8. Rotate – Click on this icon to rotate text by degrees. Drag the slider to the right to 

rotate the text clockwise or left to rotate it counter-clockwise by the number of 
degrees indicated on the slider. You may also type the number of degrees to rotate the 
text in the field near the bottom (this feature does not work for Mac OS 10.2). 
Positive numbers rotate the text clockwise and negative numbers rotate it counter-
clockwise. 

 
9. Shadow – Add a shadow to the text. 

 
• Use the Opacity slider to affect how deep or light the shadow is. 
• Click on the Color box to choose what color the shadow will be. 
• Click on the shadow in the area to the top right and hold the mouse button while 

dragging to move the shadow around. You may also use the arrow keys on the 
keyboard to nudge the shadow. 

• Ensure that the Enable Shadow box is checked (uncheck the box to remove the 
shadow). 

• Click OK to place the shadow. 
 



 Memories Builder 7—User’s Guide 

 

38 

Edit Shapes 
The Shape Tools allow you to modify shapes in a number of ways, including rotation, 
transparency, fills, and borders. Selecting a shape on a page brings up the following tool 
icons just above the workspace: 

 
Note: If you are unable to see all of these icons, click off of the shape, drag the Frame Adjustment 
bar (the bar in between the Canvas and the Contents window) to the left, and select the shape 
again. 

 

Icon Descriptions: 
1. Type – Changes the basic shape (e.g. changing from a triangle to a circle). 
2. Points/Sides – If the number of points or sides is not pre-determined by the type of 

shape (e.g. polygons or stars), this drop-down will change the number of points or 
sides the shape has. 

3. Border Color – Changes the color of the shape’s border. 
4. Border Thickness – Changes the thickness of the shape’s border (including zero width 

to remove the border). 
5. Rotate – Turns the shape the amount and direction you set with the slider. 

 
6. Zoom – Increases (+) or decreases (-) the size of the shape. 
7. Fill – Changes the color of the shape (not including the shape’s border). Alternately, 

this icon allows you to fill the shape with an image instead of a color. The shape then 
acts as a border for the image. To do this, choose Image instead of a color. 

8. Shape Image Editor – Allows editing of the shape fill image. 
• Use the Zoom buttons to use a larger or 

smaller portion of the image in the shape. 
• Click on the Replace Image button to choose 

another image to fill the shape. 
• Click on the Reset button to return the image 

to its original state. 
• Click on the image and hold the mouse button 

down as you drag to move the image around. 
• In order to rotate the shape image with the 

shape, put a check in the Rotate image with 
shape box. If the box is not checked, the image 
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will retain its orientation with respect to the canvas as the shape is rotated. 
• Click OK to accept the changes. 

9. Fill Opacity – This shape fill property allows you to make shape fills semi-transparent 
(the original state of the shape fill is 100% opaque – not transparent at all). The 
percentage you choose will determine how transparent or opaque the shape fill is (the 
lower the percentage, the more transparent). You may also type an opacity percentage 
into the text field near the bottom of the Opacity dialog (this feature does not work for 
Mac OS 10.2). 

 
10. Shadow – Add a shadow to the shape. 

 
• Use the Opacity slider to affect how deep or light the shadow is. 
• Click on the Color box to choose what color the shadow will be. 
• Click on the shadow in the area to the top right and hold the mouse button while 

dragging to move the shadow around. Alternately, use the arrow keys on the 
keyboard to nudge the shadow. 

• Ensure that the Enable Shadow box is checked (or uncheck to remove). 
• Click OK to place the shadow. 

 
Edit Layers 
Memories Builder puts each page and section object on its own layer. The order layer 
determines which objects display on top of other objects if they overlap. 

 

General Guidelines 

• A video on the canvas will always display on top of all other objects.  
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• Multiple videos that overlap will not display in a predictable manner (the overlap 
order may change from computer to computer), which may make it impossible for 
some viewers to access the player controls. Recommendation: never overlap video 
files. 

• Section objects will display on top of other kinds of objects (except videos). 
• Master borders and objects will display on top of most objects, except videos and 

section objects. 
• Page objects will display underneath all other kinds of objects. Be careful to not 

place page objects under master or section objects. Also, check portrait pages to 
ensure that portrait images and student names are not under master and section 
objects. 

• Hot Spots will display on top of other page objects. 
• The most recently placed page objects display on top of older page objects. 
 

To adjust layers:  
1. Select the object to adjust.  

 
2. Select the desired action from the Modify menu or click with the right mouse button 

on the object to change and select the action from the drop menu.   
Note: Videos will stay as the top layer.  Hot Spots cannot be moved underneath other objects. 

 
• Bring to Front – Places the object on top of all other similar (page or section) 

objects. 
• Send to Back – Places the object behind all other similar objects. 
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• Bring Forward – Moves the object up one layer. 
• Send Backward – Pushes the object back one layer. 

 
Auto Page Builder 
As an alternative to placing images on pages one at a time, Auto Page Builder will place 
a number of selected images on pages automatically. It can be an excellent tool for 
getting a large number of images on pages in preparation for more detailed layout and 
editing of each page. 
1. To begin, select a section in the Contents window. Auto Page Builder will place any 

new pages it creates in that section. 
2. Choose Auto Page Builder from the Insert menu. 

 
3. Click on the Add button (d) to browse for the images to include in the Auto Page 

Builder process.  
• Select either folders or individual files. 
• To select multiple files in sequence, click on the first file and then Shift-click on 

the last file.   
• Select multiple random files by holding down the Ctrl key (Apple key on the 

Mac) as you click on files. 
• When you are satisfied with your selection, click on Open (Choose on the Mac). 

This will return you to the Auto Page Builder dialog. 
4. The selected files will appear in the box at the top left of the Auto Page Builder 

dialog (a).  
5. Click on an image in (a) to see a preview of it in the preview area (c). 
6. To remove an image or folder from the Auto Page Builder process, click on it in (a) 

and then click on the Remove button (d). 
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7. If an image is on its side, click on it in (a) and then click on the Rotate button (d). 
8. Checking the Add Image Title as Caption box in (b) will place a text box below each 

image with the name of the file in it. 
9. Checking the Use Drop-shadows box in (b) will place a shadow underneath each 

image, giving it more of a 3-dimensional effect. 
10. If any of the items in (a) are folders that contain subfolders, checking the Include 

Subfolders box in (b) will create a new subsection for each subfolder using the name 
of the subfolder and place the images from the subfolder on pages in the subsection. 
For example, if a Dances folder has two subfolders, Homecoming and Prom, the 
Auto Page Builder process will create two new subsections named Homecoming and 
Prom and will place all of the images from the subfolders on pages in their respective 
subsections. 

11. Checking or unchecking the boxes in (e) determines the number of images that Auto 
Page Builder will place on each page. 

12. When you are satisfied with your selections, click OK. Memories Builder creates the 
pages and indicates its progress on a status bar.  

13. Review each page Memories Builder creates and make sure you are satisfied with the 
size and location of every image. All images can be moved, resized, and edited (see 
p. 33). 
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Class Portraits 
 
Critical information about Class Portraits sections: 
• Automatic Page Creation: Memories Builder automatically alphabetizes portrait 

images and creates pages for them during the import process. 
• Ideal Portrait Image Aspect: Portrait page templates use an aspect ratio of 4:5 for 

portrait images (for example, 100 pixels wide by 125 pixels high). 
• Check Portrait Page Template: The arrangement of portraits on a page can only be 

changed by changing the template for the entire section (see p. 49). If objects from 
the Master Overlay overlap portrait names or images, suppress Master Overlay 
objects in the portraits section (see p. 54). 

• Time-Saving Preparation: Sort portrait images into folders according to grade 
before importing and import one grade at a time. 

• Hot Spot Link: Linking directly to a portrait page is not allowed (because every 
change to the portrait section would break the link). Instead, create a title page (e.g. 
Junior Class Portraits) for the portrait section in the main Class Portraits section, 
move it so that it is immediately before the portrait section, and link to the title page. 

In addition to the portrait images, Class Portraits sections include the ability to attach a 
personal message, an audio clip, and a video clip to each portrait. See the Edit Portraits 
section on p. 47 for more information. 
 
Importing Class Portraits 
To begin creating a Class Portraits section, click on the Portraits icon or select Import 
Portraits from the Portraits menu.  

 
The dialogue box below will appear. 
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• Individual Files 
This is the default method for importing portrait images. The general process for 
importing portraits is a four step process. Click on the Individual Files button and 
then click Continue to begin (see Portrait Process – Individual Files below). 

• Another Memories Builder Project 
If you created one or more class portrait sections that you wish to bring into the 
current project, use this option. First, click the button next to Another Memories 
Builder Project and then click Continue. See p. 79 to continue. 

 

Portrait Process – Individual Files 

Step 1: Select Portrait Files 
After clicking the Continue button, Memories Builder will display an instruction screen. 
Read the instructions and click Continue. Memories Builder opens a browse window. 

 
Find the portrait source files—the original electronic images of the student body and 
faculty. Original images are usually found on a CD provided by a school photographer or 
in a directory of scanned photos. 

Recommendation: If portrait images are not already sorted by grade, sort them into 
folders before importing them into Memories Builder. This will greatly simplify the 
Import Portraits process. Also, you may add portrait images to a grade at any point in 
time. 

Select the image files to import. Select one or multiple files.  
• Select multiple files in sequence by clicking on the first file and then Shift-clicking on 

the last file.   
• Select multiple random files by using Ctrl-click (Apple-click on the Mac). 
After selecting all the files to use, click Continue. 
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Step 2: Choose Grade 

 
In the Choose Grade dialog, click on the pull-down menu and choose a grade for the 
portrait images. When Memories Builder creates pages for the portraits, it will create 
them in the section you choose in this step. 
If the grade that corresponds to the images does not appear in the pull-down menu, click 
on the Create New Section button. Enter a name in the prompt that appears and click 
OK. 
After selecting the grade, click Continue. 
 

Step 3: Choose Name Convention 

 
If the portrait image file names include the students’ names, choose a Portrait File 
Naming Convention. The information below the selection box and example portrait will 
help you confirm that you’ve chosen the proper naming convention.  
If the portrait images do not include the students’ names, select File name does not 
include person’s name and enter the names manually after the import process is complete 
(see Edit Portraits on p. 47). 
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Step 4: Page Template and Name Style 

 
• Choose a page template from the list of available templates. The first number in the 

template name indicates how many portraits per page the template has. 
• The second part of this dialog is for setting the font, styles, and color of the text 

below each name on portrait pages. Choose text styles as you would in the regular 
Font Style Chooser (see #2 under Add Text on p. 26).  

Click OK when you have made your selections. 
 

Automatic Page Generation 
Memories Builder will begin importing the portrait images. 

 
After importing, Memories Builder will generate pages for the portraits. The portrait page 
names will show the range of last names on the page. 
 
Each portrait section has its own title on the Section Overlay (e.g. Senior Class). To edit 
the title, select the section in the Contents window and double-click the title on the 
canvas to change the text or font style. 
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Edit Portraits 
The Edit Portrait Data window is used to change the student name, linked files, and edit 
the portrait image.  
1. Locate the page with the portrait image in the Contents Window and click on it. 
2. Select the Portrait on the page canvas to change by double-clicking the photo. This 

brings up the Edit Portrait Data window. 

 
3. Edit the text fields, i.e. correct a name, add a movie, or link to a personal page. 
4. The Middle Initial, Text, Personal Sound, Personal Movie, and Personal Page fields 

are optional.  The text field is for entering in any miscellaneous information that the 
yearbook staff deems appropriate. 

5. Click on the open folder icons next to the Personal Sound or Personal Movie fields 
to associate a corresponding file with a student’s portrait. In the final product, when 
viewers click on the student’s portrait, a box will pop up that allows them to watch 
the Personal Movie or listen to the Personal Sound by clicking on a button. Click on 
the trash can to remove a Personal Sound, Personal Movie, or Personal Page. 

6. Clicking on the open folder icon next to Personal Page will pop up a box that 
displays all of the pages in the project. Using this, a page could be selected to 
associate with the student (for example, a 15 Seconds of Fame page). 

 
7. Use the Delete button when a photo does not belong in the Class Portraits section. It 

will delete the file permanently from your project directory. 
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Note:  Individuals in any of the Class Portrait sections cannot be added without adding a 
photo. If no photo is available but the yearbook staff wants to include a student, import a 
“filler photo” image and associate the student’s name with it. 

8. To edit the image itself (cropping, zoom, etc.), click on the Edit Image button. This 
will bring up the Portrait Editor. 

 

a. Use the Zoom In icon  to increase the size of the image or the Zoom Out 
icon  to decrease the size of the image. 

b. To change the orientation of the portrait image (landscape or portrait), use the 
Rotate buttons.  

c. To change the cropping of the image, click on the image and hold the mouse 
button down while dragging. 

d. Clicking on the Reset Portrait button will restore the portrait image to its 
original state (the way it was just after importing it). 

e.  The Actual Size button will reset the image to its original size. 
f. When you have finished cropping the portrait, click OK. 

9. Memories Builder will save changes whenever you select another student or close the 
Edit Portrait Data dialog. To keep from saving changes, click on the Revert button 
to undo changes to a record.  

10. You may select other Portrait records and images to modify by clicking on the Next 
button or a name in the pane on the left side of the Edit Portrait Data dialog. 

11. When finished with all modifications, click Close. Memories Builder will recreate 
the pages in the portrait section. 
Recommendation: Make all changes to portraits of students in the same grade before 
closing the Edit Portrait Data window. This will reduce the amount of time spent 
waiting for Memories Builder to recreate portrait sections after changes. 
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Portrait Page Templates and Name Settings 
Memories Builder provides a number of pre-designed Portrait Page Templates with a 
different number of portraits per page and different layouts, as well as options for 
changing the font, styles, and color of the name below each image on portrait pages. 
1. To modify a portrait page template or name settings, click on a portraits section or 

any of its pages and select Portrait Page Template and Name Settings from the 
Portraits menu. The following dialog appears: 

 
2. Select a Page Template from the list at the top. 
3. Use the options in the Text Styles to change the way the names on portrait pages will 

appear. It uses the same options as the Color Chooser (see p. 26). 
4. Click OK. 
 
Change a Portrait Section Background 
1. To change a portrait section’s background image, double click on the name of the 

portrait section. 
2. Click on the open folder icon next to the Background Image field. 
3. Select a Section Background from one of the directories in the left pane. 
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4. To adjust the opacity (to decrease the contrast with the portrait images and names), 
click on the Opacity drop-down and choose a percentage (the lower the percentage, 
the more transparent the background image will be). 

5. To apply an effect to the background image, choose an option from the Image Effect 
drop-down menu. See effect descriptions on p. 34. 

6. To use a custom image, see Create a Custom Background Image on p. 57. 
7. When finished, click OK. 
 
Student Index 
Memories Builder provides the ability to link a student’s portrait to the pages on which 
the student appears or is referenced (as part of a club, has featured artwork, etc.). Viewers 
can then jump to those pages from the student’s portrait. 
1. Import all student portraits before indexing (see p. 43). 
2. Click on a page in the project that contains images of students or references to 

specific students. After identifying the students in the images, choose Page 
Properties from the Modify menu, or double-click on the name of the page. 

3. In the Page Properties dialog, click on Add Names to Index…  

 
4. The Add Searchable Names dialog comes up. 

 
5. Locate the first person in one of the page’s images by entering all or a portion of the 

person’s name in the First Name or Last Name fields, selecting a grade, and clicking 
Lookup. 
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6. Memories Builder will return a list of students that fit the search parameters you 
entered. To browse through results, click on the arrow buttons directly underneath the 
image of the student. 

7. Once you have located the correct student, click on the Add button to put the student 
in the People on this page box. 

8. Repeat steps 5-7 for every student that is associated with the page. 
9. When you have finished, click on the Close button. Memories Builder will then 

create a link from the portrait of each student that was in the People on this page box 
to the page. Click on the OK button in the Page Properties dialog. 

10. To check the link, save the project and then enter Preview mode by clicking on the 
Preview icon.  

11. In Preview mode, click on the Menu button and choose a Class Portraits section. 
12. Browse through the portrait section until you locate one of the students you added 

into the People on this page box in step 7. Click on the portrait to bring up the 
student’s personal screen. 

 
13. In the personal screen, click on the arrow next to the My Portrait Page menu (bottom 

right) and select Find My Pages.  
14. The menu will disappear as Memories Builder populates the list of pages (in the 

finished yearbook, the list of pages will already be populated, and viewers will be 
able to select from the list immediately). Click on the arrow again to see the page(s) 
where the student appears. 

 
15. Choose one of the pages by clicking on it. Memories Builder will jump to that page. 
16. After exiting Preview mode, repeat steps 2-8 for all of the pages in the project.
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Project Presentation 
 
The Master Overlay (putting an object on every page in the project) 
The Master Overlay is a layer where students may place an image or text on every page 
of the project, such as a title bar with the school name. When placing an item on the 
Master Overlay, it appears on top of other objects in the project, with the exception of 
section overlay objects and videos.  Master Objects can include images, text, and Hot 
Spots. 

 

Enable the Master Overlay 
1. By default, the Master Overlay should be enabled. If the overlay is enabled, the 

Master Level icon will have a partially transparent yellow paper icon over part of it: 

 
If the Master Overlay is not enabled, the yellow paper icon will not appear: 

 
2. To enable the overlay, double-click the Master Level or choose Project Properties 

from the Modify menu. 
3. In the Project Properties dialog, check the box next to Add a Master Overlay to this 

Project. 

 
4. Click OK. Memories Builder will now show the yellow transparent icon over the 

Master Level icon to indicate that the Master Overlay is enabled. 
 

Add Objects to the Overlay 
Adding objects to the Master Overlay is just like adding objects to regular pages.  
a. Adding images – Click on the Image icon. Browse for an image file and click Open. 

Click on the canvas and place the image. For more detailed information, see p. 24. To 
review the process for editing images, see p. 33.  
Note: In order to preserve transparency in images, you must use the PNG format for the 
image. 

b. Adding text – Click on the Text icon. Choose your font, size, style, alignment, and 
color. Type your text in the text preview box. Click OK. Click and drag on the 
canvas to place text. For more detailed information, see p. 36. 

c. Adding links – Click on the Hot Spot icon to link to a file, movie or Web site.  In the 
Link Hotspot To dialog, choose what kind of a link to create, and then browse for the 
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appropriate file or project page or type in a web address. Enter a Tool Tip, if desired. 
Click OK. Click and drag to define the Hot Spot region. To read more, see p. 31. 

d. Adding shapes – Click on the Shape icon and select a shape from the drop-down 
menu. Click on the canvas and hold down the mouse button as you drag open an area 
to place the shape. See p. 32 for more information on shapes. 

e. Navigation Buttons – Memories Builder includes a built-in navigation bar, which 
you can see in Preview mode and select by choosing Preferences from the Edit 
menu (Navigation tab).  
The Master Overlay provides the possibility of creating additional navigation buttons 
that will display on every page in the project, such as a button to return to the title 
page. To create a navigation button on the Master Overlay: 
• The Memories Builder Resources disc provides several blank button images (in 

the Buttons folder). Add one of these blank button images or your own custom 
button on the Master Overlay (see a above). 

• When using a plain button image, add text on top of the button so the viewer 
knows what the button is for (see b above). 

• Create a Hot Spot on the Master Overlay that links to the destination page and 
place it on top of the button (see c above). 

• Check the link in Preview mode to ensure that it works as expected. 
 
Section Overlay 
A Section Overlay is similar to the Master Overlay, except that it only applies to a 
section. Section Overlay Objects can be useful for displaying section titles and showing 
images on every page of a section. 
 

Enable the Section Overlay 
1. By default, section overlays are not enabled (except for portrait sections). To add an 

overlay to a section, double-click on the name of the section in the Contents window.  
2. In the Section Properties dialog, check the box next to Add an Overlay to this 

Section. 

 
3. Click OK. Memories Builder will now show a yellow transparent icon over the 

Section icon to indicate that the Section Overlay is enabled. 
 

Add Objects to the Overlay 
Adding objects to the Section Overlay is just like adding objects to regular pages.  
a. Adding images – Click on the Image icon. Browse to find the image and click Open. 

Click on the canvas and place the image. For more detailed information, see p. 24. To 
review the process for editing images, see p. 33. 
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b. Adding text – Click on the Text icon. Choose your font, size, style, alignment, and 
color. Type your text in the text preview box. Click OK. Click and drag on the 
canvas to place text. For more detailed information, see p. 36. 

c. Adding links – Click on the Hot Spot icon to link to a file, movie or Web site.  In the 
Link Hotspot To dialog, choose what kind of a link to create, and then browse for the 
appropriate file or project page or type in a web address. Enter a Tool Tip, if desired. 
Click OK. Click and drag to define the Hot Spot region. To read more, see p. 31. 

d. Adding shapes – Click on the Shape icon and select a shape from the drop-down 
menu. Click on the canvas and hold down the mouse button as you drag open an area 
to place the shape. See p. 32 for more information on shapes. 

 
Removing Master and Section Overlays from a Page or Section 
To keep Master Overlay Objects and Section Overlay Objects from appearing on specific 
pages or in certain sections without deleting them from the entire project: 

Note: To delete Master Objects and Section Objects from the entire project, select the Master 
Overlay or Section Overlay, click on the object to delete, and choose Clear from the Edit 
menu or hit the Delete key. To remove a Master Border, choose Project Properties from the 
Modify menu, and select No Master Border from the Master Border area. 

1. Double-click on the name of the appropriate page or section in the Contents window. 
The Page Properties or Section Properties dialog will appear.  

  
2. Uncheck the Show Master Overlay box or the Show Section Overlay box. To remove 

a parent section's Section Objects from a section, uncheck Show Parent Section 
Overlays in the Section Properties dialog. 

3. Click OK. 
 
Creating and Importing a Custom Master Border 
You can design your own Master Border in another program like Adobe Photoshop. 
Memories Builder provides an easy method for importing it.  
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Design Hints and Suggestions: 
• The project canvas is 800 pixels wide by 600 pixels high. 
• Save the file in PNG (.png) format. This is the only way to preserve transparency in 

Memories Builder. 
 
There are two methods for using your design images in Memories Builder: 

Master Border Method 
Use this method if your design uses all of the project's borders (top, sides, and bottom). 
1. After creating your image, save it to the following location: 

Memories Builder 7/Components/Themes (the Memories Builder 7 folder is located 
where Memories Builder was installed – usually in Program Files on a Windows 
computer or in the Applications folder on the Mac) 

2. In order for the custom Master Border to work, it will need to have a filename in the 
following format: 
<name>_1.png (e.g. stars_1.png) 

3. When you reopen Memories Builder, you will be able to access the new Master 
Border in the Project Properties window or during the project creation process. 

Master Overlay Method 
Use this method if you are using several images, or if your design image only uses a 
single border (a bar along the top, for example). 

1. Ensure that the Master Overlay is enabled in Project Properties (see p. 52). 
2. The semi-transparent yellow paper icon on the Master Level icon will show the 

presence of a Master Overlay.  

 
3. Assemble your design images on the Master Overlay using the instructions for 

adding images (see p. 24). 
 
Navigation 
Memories Builder provides full navigation to viewers. As a part of creating your project, 
you will be able to select a navigation bar that viewers will use when viewing the project. 
To see the bar, go to Preview mode (click on the eye icon).  
Note: The navigation bar will pop up in the gray area of the canvas titled Pop-up Navigation 
Area as a user moves the mouse to the bottom of the presentation. Avoid putting videos and Hot 
Spots in this area, since they may interfere with the navigation bar. 

Choosing a Navigation Bar 
1. Choose Preferences from the Edit menu (Memories Builder menu on the Mac). 
2. Click on the Viewer tab. 
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3. Double-click on the names of folders to open them. Click on the name of a 
navigation bar to see a preview of the buttons. 

 
4. When you have selected a navigation bar you like, click OK. 
5. Click on the Preview icon. To see the navigation bar, move the mouse near the 

bottom of the presentation. The navigation bar will appear. 

 
 

Navigation Bar Reference 

 

Button Descriptions: 
Note: Buttons like the Portraits button that don’t apply to your project will not appear in 
the final product.  
1. Table of Contents – Clicking on this button will pop up a window that displays all of 

the sections and pages in the project. Viewers can click on a page to jump straight to 
the page. 

2. Help – Clicking on this button brings up a help file for the presentation. 
3. Portraits – If the project includes a Portraits section, viewers can click on this button 

to search for friends. 
4. Show Links – This button allows viewers to reveal Hot Spots in the presentation. 

They will show up with a thick border outline, color coded as follows: 
a. Red – Web link 
b. Blue – Audio file 
c. Yellow – Movie file 
d. Violet – Text file 
e. Green –Project page link 

5. Browse Arrows – Click on the Next button to step forward from page to page 
through the project presentation. Click on the Back button to step backward through 



 Memories Builder 7—User’s Guide 

  57 

the project. The small right and left arrows work like a Web browser’s forward/back 
buttons. 

6. Music Buttons – Click on the Play Music button to toggle background music on and 
off. Click on the up/down arrows to increase or decrease volume. 

7. Settings – This button sets up Memories Builder to automatically move to the next 
page in timed intervals. Clicking on this icon will bring up a dialog that will allow 
viewers to set the time interval and turn auto advance on and off. When auto advance 
is enabled, Memories Builder will display a pause button that pauses auto page 
advance when clicked on. 

8. Exit – Closes the presentation. 
 
Add/Change Background Image 
Background images go behind all other objects on a page. They help to create visual 
interest, unify sections of the project by using a common background, and give the 
project a more professional look. Background images are assigned by section.  
1. To add a background to a section, select the section in the Contents window. 
2. Double-click on a blank spot on the page canvas. 
3. In the Section Background dialog (shown at right), 

browse through the available backgrounds by 
clicking on the plus symbols (arrows on the Mac) 
next to folder names and selecting background 
names. A preview will appear in the box on the 
right. 
• To adjust the opacity (to decrease the contrast 

with the portrait images and names), click on 
the Opacity slider and choose a percentage (the 
lower the percentage, the more transparent the 
background image will be). 

• To apply an effect to the background image, choose an option from the Image 
Effect drop-down menu. See effect descriptions on p. 34. 

4. Subsections will inherit their parent’s background image unless the subsection has its 
own background. 

5. To learn about the functionality of the Add button, see Create a Custom Background 
Image (below). 

 
Create a Custom Background Image 
Personalize the project by creating custom background images from school photos or 
student art. Background images can be in JPG, GIF, or PNG formats, and should be 800 
pixels wide by 600 pixels high. 
1. Create the image in an image-editing program. 
2. In Memories Builder, click on a section in the Contents window. 
3. Double-click on the current background image or a blank spot on the canvas. 
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4. Click on the Add button. 

 
5. In the File Preview dialog, browse to select the background image you created and 

click on it. 
6. Click Open. 
7. The new background image should now be selected. Click OK. 

 
 
Creating Custom Page Templates 
Custom page templates provide a further level of customization by allowing you to create 
new page templates based on pages you have created.  

Regular Page Template 
After building a page: 
1. Choose Save Page Template from the File menu. 
2. Type a name in the Name field of the Save Page Template dialog and click Save. 
3. The new page template will now appear in the Select Page Template dialog that 

appears when you click on the New Page icon or choose New Page from the Insert 
menu. 
Note: The new custom page template will substitute blank image boxes (blue) and blank text 
boxes (yellow) for the original page’s images and text. The template will also include any 
shapes that were on the page. 

Auto Page Builder Template 
This option will allow you to add to the templates that Auto Page Builder uses. Note that 
Auto Page Builder templates cannot have more than four images on a page. After 
building a page: 
1. Choose Save Auto-Builder Template from the File menu. 
2. Type in a name for the new template and click the Save button. 
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3. Auto Page Builder will now use the new template along with the default templates. 
The selection of templates considers the number of images per page setting (1-4), the 
orientation of the images (portrait or landscape), and also uses a random factor. 

 
Organizing Sounds and Music 
To further enhance the final CD, add background audio, an audio file (typically music) 
that will play throughout the pages in a section. 

To add audio clips to individual pages (especially spoken word), Memories Builder also 
offers a page narration feature. Narration is assigned by page, and pauses the background 
audio. When the narration clip finishes, background audio resumes. 

Background audio follows an “inheritance principle.” This means that a subsection will 
play the audio selected for its parent section unless another background audio file is 
selected for the subsection. 

Memories Builder comes with a number of license-free music selections that you can use 
in your project. Look for the Memories Builder Music icon.  

Recommended sound file format information – 
Full Songs: MP3 format, 128 kbps (160 for better quality), Stereo channels 
Loops: WAV, 44,100 Hz, 16 bit, Stereo channels  

See the Preparing Audio Files guide (in Appendix D) on page 83 for more information. 
Note: You can also link to an audio file with a Hot Spot. To learn more, see p. 31. 

 

Background Audio 
1. In the Contents window, double-click a section name to add background audio to it. 

2. In the Section Properties dialog, click on the Memories Builder Music icon  to 
select one of the music files that comes with Memories Builder, or on the open folder 
icon next to the Background Audio field to browse for one of your own music files. 

3. In the File Preview window, browse to an audio file. Memories Builder supports the 
following audio file formats: WAV, MP3, AIFF, AU, MIDI, and System 7 sounds. 
Select the music file and click Open. 
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4. The Section Properties dialog also provides the following options: 
a. Loop puts the music in continuous replay mode until the viewer encounters 

another background audio selection. 
b. Play provides an audio preview of the background audio in the Section 

Properties dialog box. 
c. Clear removes the background audio file for this section (any music selected in a 

parent section will continue to play through this section). 
d. Play None – Selecting this box will disable all background audio for this section, 

including inherited background audio. 
 

Page Narration 

Although Page Narration is typically spoken word, it can be any type of sound file. 
Remember that it will pause the background audio while playing. 
1. In the Contents window, double-click a page name to add page narration. 
2. In the Page Properties dialog, click on the open folder icon next to the Page 

Narration field to choose a pre-recorded file. To record your own, see step 5. 

 
3. In the File Preview dialog, browse to the file to use. Memories Builder supports the 

following audio file formats: WAV, MP3, AIFF, AU, MIDI, and System 7 sounds. 
The Preview box in the left side of the File Preview dialog allows a preview of the 
audio file by clicking on the Play button. 

 
4. Select the file and click Open. 
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5. In the Page Properties dialog, several additional boxes and buttons provide 
additional options. 

 
• The Play button provides a preview of the audio in the Page Properties dialog 

box. 
• The Record button  

Instructions for PC computers: To prepare for recording page narration, plug a 
microphone into the computer. Select the microphone input in the Recording 
Control panel (choose Properties from the Options menu, and then select the 
Recording radio button) of the Windows Volume Control. This can be accessed 
from the Start button by going to Program Files > Accessories > Entertainment.  
Instructions for Mac computers: Click on the Apple in the top menu bar, and 
choose System Preferences. Choose the Speech item in System Preferences. In 
the Speech window, make sure that the Microphone field is set to Microphone or 
Internal Microphone (rather than Line In). 
After setting up, click the Record button. A new window will pop up that 
instructs you to begin recording. When you have finished, click the Stop button. 

• Clear removes the page narration for this page.  
• Don’t play narration disables the page narration to allow testing pages with and 

without narration in Preview mode. 
6. When finished, click OK.
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Finalizing the Project 
Use the steps in this section to prepare your project to send to Yearbook Interactive for 
duplication. This process is required before project submission. It may take up to two 
weeks to complete. Please plan accordingly.  
 
Preliminary Suggestion: Back Up the Project  
1. If hard drive space is not limited, save a backup copy of the project file. Choose 

Backup Project from the File menu.  
2. Select the backup location by clicking on the open folder icon. Browse to a folder 

and click Select Folder. 
3. Memories Builder creates a copy of the project with the date added to the file name 

in the folder you specified. 
 
Step 1: Preview Project 
The project is created in Build Mode. Preview Mode simulates the viewing mode; it has 
all of the functionality of the final presentation, including background music, navigation 
buttons, etc. Preview the entire project before compiling it. (See the Project Completion 
Checklist in Appendix G on p. 93 for more detailed information). 
1. To enter Preview Mode, choose Preview from the Finalize Project menu or click on 

the Preview icon  on the toolbar. 

 
2. Memories Builder will go into Preview Mode. A row of navigation and function 

buttons will appear at the bottom of the presentation as you move the mouse to the 
bottom of the screen. Browse through the project with the arrow icons or go to 
specific pages with the Table of Contents icon (far left). 

3. When finished Previewing, click on the Exit button.  
4. As an additional aid, you may print any page in your project by selecting the page in 

the Contents window and then selecting Print Page from the File menu while in 
Build Mode. 
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Step 2: Check Project for Errors 
This step searches the project for problems and displays a list of anything it finds. This 
function primarily searches for corrupt objects, missing files, and images and text that 
extend beyond the edge of the Canvas. 
1. Choose Step 2: Check Project for Errors from the Finalize Project menu. 
2. Memories Builder begins checking the project. 

 
3. When it has finished, Memories Builder displays a printable list of errors.  

 
Common Errors: 
• File is missing from the project folder – If you receive this error, it is because an 

object file (video, image, or text) is missing. If the project is missing a large number 
of objects, call Technical Support for assistance (877-463-6924 ext. 23). If there are 
only a few missing objects, make a note of the missing objects’ locations or print the 
error log, locate the missing objects on their respective pages (video files will be 
replaced by a blank, white background, images by a blue box, and text by a yellow 
box), and replace them with the original file or text.  

• Image: <Name of file> Image rectangle is off the canvas – This error indicates that 
an image has been pushed off the edge of a page. Select the image and move it back 
onto the page. 

• Text Box: "<Excerpt of text>" is off the canvas – This indicates that part of text box 
may be off the canvas, possibly making the text unreadable. Move the box fully on 
the canvas to show all of the text. 

If you have questions, contact Yearbook Interactive Tech Support at (877) 463-6924 ext. 
23. 
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Step 3: Check Spelling 
Ensuring accuracy in a project’s spelling is a critical part of professionalism. The spell 
checker will go through the entire project, checking all text boxes for spelling. To run the 
spell check: 
1. Click on the Spell Check icon or choose Check Spelling from the Finalize Project 

menu. 

 
2. If the spell checker finds misspelled words, it will launch the Check Spelling dialog. 

The following image and list describe the function of each button in the dialog: 

 
a. Ignore – Leaves the current word as it is and moves on to the next misspelling. 
b. Ignore All – Leaves the current word and any identical words in the entire project 

as they are. 
c. Change – Replaces this instance of the word in the Not in dictionary field with 

the one in the Change to field. 
d. Change All – Replaces this and all subsequent instances of the word in the Not in 

dictionary field with the one in the Change to field. 
e. Suggest – If the spell checker doesn’t automatically provide alternate words in 

the Suggestions field, click on this button. 
f. Add – Places the current word into the dictionary and continues with the spell 

check process. 
g. Undo – When making multiple changes within the same text box, this allows you 

to return the last word you changed to its former spelling. 
h. Cancel – Exits the spell checker. 

3. The spell check will pop up a dialog box to inform you when it has finished checking 
the text in the project. 
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Step 4: Proof/Lock Project 
The proofing of your project is so critical that Memories Builder requires that all pages 
be proofed and locked before submission. Locking the pages ensures that, once proofed, 
no changes, additions, or deletions can be made to a page or section. The Proof Project 
process also requires an adviser or editor to create a password which will limit access to 
proofed pages. 
 
Before proofing and locking pages, check the size of your project. If your project is too 
large to submit, it will be easiest to make changes before locking sections and pages. To 
check the size of your project, choose Compare to Plan from the Modify menu. Check 
the figures in the Actual column to see the size of your project and its components.  
 
For recommendations on reducing the size of your project, see Appendix E on p. 87. 
 
1. Click on the Master Level to begin. 

 
2. If the project has a Master Overlay, check the objects on it carefully. Make any 

necessary fixes. If everything is right, click on the Lock icon. 

 
3. Memories Builder will launch a screen prompting you to provide an e-mail address, 

choose a password, and type in your initials. Enter the requested information. You 
will be prompted for the password and your initials every time you go back to 
locking pages, so be sure to make note of the values you enter. Then click the 
Continue button. 

 
4. Memories Builder will lock the Master Level, as indicated by a lock icon over the 

Master Level icon. 
5. Now select the first section in the project and proceed to lock sections and pages (the 

section must be locked before any of its subsections or pages can be locked). 
6. Be sure to expand all sections by clicking on the plus symbol (arrow icon on the 

Mac) next to every section name. 
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7. If you would prefer not to enter your password as you lock each page, check the box 
next to Allow locking without requiring password in the Project Password dialog. 

8. Once a page is locked, users will be unable to select or change objects. If you later 
discover a problem with a page, you may unlock it by selecting the page or section 
and clicking on the Lock icon. 

9. If at any time you forget your password, click the Forgot Password button in the 
Project Password dialog to have it e-mailed to you. Click Continue when you have 
finished. 

 
10. Save the project after proofing. 
 
Step 5: Export for Submission 
The final step before sending a project to Yearbook Interactive is the Export for 
Submission process. Memories Builder automatically compresses all of the project 
elements into a single file. Make a note of the location of the submission file (see step 2 
below). The location is needed in order to burn a CD of the submission file. Errors or 
problems with the Export for Submission process may be difficult to solve. Call Tech 
Support toll-free at (877) 463-6924 ext. 23 for assistance. 
 
This process may take a long time (20-30 minutes typically). Do not turn off the 
computer until the process is finished. 
1. After locking the project, choose Step 5: Export for Submission from the Finalize 

Project menu.  
2. The software will prompt you to choose a save location for the submission file. Click 

on the open folder icon to select a location. Browse to a folder and click on the Select 
Folder button. Make a note of the chosen location. 
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3. After choosing a save location, click on the Compile button. 
4. During the Export for Submission process, Memories Builder will display a warning 

if there is something wrong with the project. 
5. When the process has completed, Memories Builder will display a message showing 

the size of the project. In order for your final presentation to fit on a CD, the project 
should be less than 600MB. If the process completes successfully, you will find a file 
named SendToYBI.ybz in the location you specified in step 2. 

 
Submit the Project 
Burn the SendToYBI.ybz file to a CD. Send the CD to Yearbook Interactive by mail for 
production and replication.  
Note: If you are using Roxio Easy CD Creator, please burn your CD as a DataCD project. Do 
not use DirectCD. 

To mail the compiled project: 
Send a Final Submission Form (go to www.ybi.com/support.html to download the latest 
form) and the CD with the submission file to the address shown on the Final Submission 
Form. Fill out all requested information and sign the form. If you have any questions, 
contact your Customer Service Representative at 1-877-463-6924. 
 

http://www.ybi.com/support.html
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Appendix A: Interface Reference 
 
This appendix contains information about the major elements of Memories Builder, 
shown below: 
 

 
 

1. Menus (Function Definitions) (p. 69) 
2. Main Toolbar (p. 72) 
3. Contents Toolbar (p. 72) 
4. Contents Window (p. 73) 
5. Canvas (p. 75) 
6. Space Used Indicator (p. 75) 
7. The Frame Adjustment Bar (p. 76) 
8. Pop-up Navigation Area (p. 76) 
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1. Menus (Function Definitions) 

File 
New Project—Closes the current project to create a new project. 
Open Project—Closes the current project to open an existing project. 
Close Project—Closes the current project. 
Save—Saves the project with the current name in the current location. 
Save As—Saves the project in a custom location with a new name. (The previously 

named project will exist separately under the original name.) 
Save Page Template—Uses the objects on the current page (images, text boxes, and 

shapes) to create a page template. 
Save Auto-Page Template—Uses the objects on the current page (images, text boxes, 

and shapes) to create a page template for Auto Page Builder.  
Print Page—Prints the current page for proofing or preview. 
Backup Project—Creates a safety copy of the open project and all of its files. 
Restore from Backup—Returns a project to the state it was in when it was backed up 

with the Backup Project menu item. 
Recent Projects—A list of the projects you have opened recently. Click on a project 

to open it. 
Exit—Closes the current project and quits the application. 

 

Edit 
Undo—Cancels the last operation. 
Redo—Restores the “undone” operation. 
Cut—Removes a page object to the clipboard to be pasted in another location. 
Copy—Copies a page object to the clipboard to be pasted in another location. 
Paste—Applies the page object stored in the clipboard to the current page. 
Clear—Permanently deletes the page object from the page. 
Delete Page or Section—Brings up a dialog for selecting and deleting a page or 

section. Useful for deleting pages or sections that are generating errors. 
Check Project for Errors—Brings up a utility that checks for errors in the project and 

displays a printable list of results. 
Check Page for Errors—Brings up a utility that checks for errors on the current page 

and displays a printable list of results. 
Select All—Selects all objects on the current page. 
Preferences—Sets a number of options for projects. See Appendix C: Project 

Preferences on p. 80. 
 

Modify 
Page Properties—Displays the Page Properties dialog to view or change: 
— Page Name 
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— Enable/Disable Page 
— Show Master and Section Overlay Objects 
— Page Narration 
— Student Index 
Section Properties—Displays the Section Properties dialog to view or change: 
— Section Name 
— Enable/Disable Section 
— Suppress Master Overlay Objects and Parent Section Overlay Objects 
— Background Image 
— Page Transitions 
— Background Audio (Music) 
Project Properties—Displays the Project Properties dialog to view or change: 
— Splash Screen Information, including the School Name and Yearbook Title (a 

screen that displays as the finished CD supplement is loading). 
— Intro Video Information—A video that plays before the presentation. 
— Master Border—A graphic or set of images that shows up on every page. 

Includes a preview of the selected Master Border. 
— School Colors—Affects the way certain Master Borders display. 
— Master Overlay Option—Creates a transparency for placing objects that will 

show up on every page in the project. 
Project Plan—Brings up the Project Planning dialog, where you can view and change 

plan attributes. 
Compare to Plan—Brings up a dialog that shows how much of the project you’ve 

built alongside a review of the projections you created in the project plan, as well 
as deadlines and assignments. 

Renumber Pages—Assigns names to the pages in a section based on the order they 
are in (useful after moving pages in a section around). 

Change Password—Allows you to change the password for locking and unlocking 
pages and sections. 

Edit Object—Allows for changes to objects on the page. 
— Opens the Text Editor when a text box is selected on a page.  
— Opens the Hot Spot Editor when a Hot Spot is selected. 
Delete Object—Permanently deletes a selected object from the page. 
Bring to Front—Makes the selected page object the front (top) layer. 
Send to Back—Makes the selected page object the back (bottom) layer. 
Bring Forward—Brings the selected page object one layer forward. 
Send Backward—Moves the selected page object one layer backward. 
Align—Brings objects into alignment with each other or the Canvas. See p. 23 for 

details. 
Show Grid—Displays a grid on the current page for assistance in placement of page 

objects. 
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Insert 
New Page—Adds a new page to the section that is highlighted or to the parent section 

of the page that is highlighted.  
New Section—Creates a section as a subsection of the currently selected section or at 

the root level if the Master Overlay is selected. 
Import Pages/Sections—Imports pages or sections from another project. The new 

page will be placed below the selected page or section in the Contents window 
of the current project. 

Import Portrait Section—Brings a portrait section from another project into the 
current project. 

Auto Page Builder—Creates and fills pages with images of your choice. See p. 41. 
Add Image—Adds an image (jpg, bmp, png, gif, tif, pic) to the current page. 
Add Text—Adds text to the current page. 
Add Movie—Adds a movie (mov, avi, mpg) to the current page. 
Add Hot Spot—Adds a Hot Spot to the current page. 
Add Shape—Pops up a menu for selecting a shape to add to the current page. 

 

Portraits 
Import Portraits—Brings portrait images into a project, alphabetizes them, and 

creates pages for the images. 
Edit Portraits—Brings up a dialog box for adding or changing the name and other 

information associated with portraits, such as a Personal Movie, Personal Sound, 
Personal Page or message. Includes tools for editing portrait images. 

Portrait Page Template and Name Settings—Opens a dialog box for selecting a page 
template for the auto-generated pages in a Portrait section and the text font and 
styles for names displayed in the Portrait section. 

 

Finalize Project 
Step 1: Preview Project—Puts Memories Builder in Preview mode, which shows 

what the final presentation will look like. 
Step 2: Check Project for Errors—Brings up a utility that checks for errors in the 

project and displays a printable list of results. 
Step 3: Check Spelling—Brings up a utility that checks the spelling in all of the 

project’s text boxes, points out errors, and suggests changes. 
Step 4: Proof/Lock Project—Brings up information on locking pages and sections 

(required before the Export for Submission step). 
Step 5: Export for Submission—Compresses the project files into a single file named 

SendToYBI.ybz in preparation for sending the project to Yearbook Interactive. 
Finalize Project Help—Brings up detailed information about the steps to finalizing a 

project. 
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Help 
Memories Builder Help—Brings up the help system, which contains topics, an index, 

and a search function for finding help with Memories Builder. 
Check for Updates—If your computer is connected to the Internet, this will check to 

see if you have the most current version of Memories Builder. 
User's Guide—Opens this User's Guide in another window, a print-ready document 

that contains complete information about using Memories Builder. 
Tutorial—Opens a document that leads you through the basic steps of using 

Memories Builder. 
Memories Builder Web Site—Launches the Memories Builder Web site, which 

contains information and updates for Memories Builder. 
Give YBI Feedback—Launches a form on the Memories Builder Web site, which 

allows you to send feedback to Yearbook Interactive. 
About Memories Builder—Displays a screen that contains copyright and version 

information for Memories Builder. 
 
2. Main Toolbar 
See Menus (Function Definitions) on p. 69 above for explanations of each of the Main 
Toolbar icon functions. 
 

 
 
1. New Project 6. Cut  11. Check Page for 

Errors  
16. Add Movie  21. Show Grid  

2. Open Project 7. Copy  12. Undo  17. Add Hot Spot  22. Edit Object  
3. Save 8. Paste 13. Redo  18. Add Shape  23. Help 
4. Preferences 9. Paste in Place  14. Add Image  19. Auto Page Builder   
5. Preview  10. Check Spelling  15. Add Text  20. Import Portraits   
 

3. Contents Toolbar 

 
 
1. New Section - Creates a new project section. 
2. New Page - Creates a new page in the currently selected project section. 
3. Properties – Brings up the properties dialog for the selected page or section, which 

allows modification of names, music selections, background images, whether master 
and section objects appear, and more. See p. 74. 

4. Lock – Locks or unlocks sections and pages. All project contents (Master Level, 
sections, pages) must be locked before exporting the project, the final step in 
submitting it to Yearbook Interactive. 
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5. Delete - Removes a page or section by clicking on the page or section in the Contents 
window and then clicking on this button.  

 
4. Contents Window 
The Contents window displays the sections and pages of 
your project.  
• Click-drag sections and pages to move them to the 

desired location in the Contents window.  
• To delete a section or page, select the section or 

page then click on the Trash icon on the Contents 
Toolbar. 

• To quickly move through pages and sections, hold 
down the Ctrl key (Apple key on the Mac) and hit the up or down arrows. 

• Click with the right mouse button (Ctrl-click on the Mac) on selected sections or 
pages to bring up a menu that allows you to modify properties:  

 
• Disable – keeps the page or section from appearing in the final presentation 

without deleting it. To enable it again, right-click (Ctrl-click on the Mac) and 
choose Enable. 

• Move to – brings up a window which allows you to choose a new location in the 
project for the selected section or page. Click on the name of the destination 
section (expand sections by clicking on the plus or arrow icon next to it) and 
click OK. 

• Delete – permanently removes the page or section from the project. 
• Properties – opens the Page Properties or Section Properties dialog for the 

selected item. See Sections and Pages below. 

Master Level/Master Overlay 
The Master Level contains all of the top-level sections in a project. The Master Overlay is 
a transparency that lies over every page. It is used for placing objects that are to be 
displayed throughout the project.  
• Objects on the Master Overlay always appear above the page objects, but below the 

section objects.  
• Logos, mascots, school name, and other titles are the perfect design elements to be 

placed on the Master Overlay.  
• The Master Overlay is enabled by default. To disable it, choose Project Properties 

from the Modify menu. 
• A yellow transparent page over the Master Level icon indicates that the Master 

Overlay is enabled.  
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Sections 

Sections are separators or dividers in the CD supplement. They typically contain pages 
related to a single subject or activity, such as homecoming or softball. Sections contain 
background images and background music that help to bind a set of pages together. 
Sections can also have a Section Overlay with objects that show up on every page in the 
section (a section title, for example). 

• The green folder icon  identifies sections.  
• When the icon is green, it has been enabled and is active. 
• When it is gray, it has been disabled and neither it, nor any of the pages contained 

therein will be displayed in the presentation CD unless re-activated. (Double-click 
the section to open Section Properties and enable it.) 

• Section properties are set by double-clicking on the 
section name or by clicking on the Properties icon.  

You may edit the following in Section Properties: 
Section Name (see p. 18) 
Enable/Disable Section (see p. 20) 
Enable Section Overlay (see p. 53) 
Show/Hide Master and Section Overlays in the 
Section (see p. 54) 
Section Background Image (see p. 57) 
Page Transitions (see p. 17) 
Background Audio (see p. 59) 

 

Pages 

The blue page icon  designates individual pages. A Page contains all of the standard 
objects, such as movies, sounds, images, hot spots, etc.  
• When the icon is blue, it has been enabled and is active. 
• When it is gray, it has been disabled and it will not be displayed in the presentation 

unless re-activated. (Double-click the page to open Page Properties and enable it.) 

• Modify page properties by double-clicking on the page 
name or by clicking on the Properties icon  after 
selecting the page. 

You may edit the following in Page Properties: 
Page Name (see p. 18) 
Enable/Disable Page (see p. 20) 
Show/Hide Overlays on the Page (see p. 54) 
Page Narration (see p. 60) 
Student Index (see p. 50) 
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5. Canvas 
The project Canvas is where students will do most of the work. The canvas size is 800 
pixels wide by 600 pixels high. When a section has been selected in the Contents 
window, the background (if already chosen) and instructions will appear on the page. 
When a page has been selected in the Contents window, all of the page objects previously 
added to the selected page will be displayed. 
 
Tips for making changes on the Canvas:   
• To change the background image, double-click on the background. The Section 

Background dialog box will open.  
• Move page objects by clicking on them, holding the mouse 

button down, and dragging them on the canvas.  
• Double-click on a text box, Hot Spot, or image-filled shape to 

open an editing window. 
• Delete or change the layer order of objects on the page canvas 

by right-clicking the mouse (Ctrl-click on the Mac) and 
choosing from the drop down menu shown to the right. Master 
Overlay and Section Overlay objects always display on top of 
standard page objects, with the exception of video. 

• The other right-click (Ctrl-click on the Mac) items are shortcuts to common object 
functions. 

 
6. The Space Indicator 
Even though a CD can hold a lot of information, its space is still limited. Since video and 
audio files take up quite a bit of space, keep an eye on how much space is being used. 
Memories Builder provides a handy visual reference bar called the Space Indicator. It is 
located in the lower left corner of Memories Builder. 

 
The Space Indicator bar shows how much space the project is using. Since the average 
CD-R has about 650MB available, the entire transparent gray rectangle represents 
650MB. The green bar indicates how much space has been used. 
The Space Indicator is only a rough approximation of the project’s current size. The 
software that allows students to view the final product takes up some room as well, so 
600MB is set as the size limit for your project. When the project reaches 600MB in size, 
the bar turns to red, indicating that the project may be in danger of using up more space 
than a CD can hold. Your project should be less than 600MB before you submit it to 
Yearbook Interactive. 
 
See p. 87 for recommendations on reducing project size. 
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7. The Frame Adjustment Bar 

 
The bar between the Contents window and the canvas can be adjusted for display 
purposes. A double arrow cursor will appear when placing the cursor over it.  Click-drag 
the bar to the left to see more of the canvas or to the right to see more of the Contents 
window. 
 
8. Pop-up Navigation Area 
The final CD presentation will include a navigation bar (see p. 55) for browsing through 
pages and accessing certain features and settings (class portrait search, auto page 
advance, music volume, etc.). The navigation bar will pop up as a viewer moves the 
mouse near the bottom of the presentation in the area indicated. Placing videos and hot 
spots in this area may interfere with the navigation bar or hot spot functionality. 
 
• To see the navigation bar, preview the project (see p. 62). 
• To change the navigation bar, choose Preferences from the Edit menu (the 

Memories Builder menu on the Mac) and click on the Viewer tab. See p. 80. 
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Appendix B: Creating a Memories Builder Project on 
Multiple Computers 
 
Introductory Note: 
Memories Builder projects are not designed to be opened, accessed, or modified by more 
than one computer at a time. Doing so will delete parts of the project. Rather than 
creating a single project and having a number of users access it, have each student create 
a project and then import all of the parts using the Import Pages and Sections function. 
 
Setup 
1. Install Memories Builder on every computer you will use to create your project. 

Ensure that you are using the latest version of Memories Builder. 
2. Assign portions of the project to each student. The typical approach is to divide the 

work among the students by section. For example, one student could work on the 
Student Life section, while another student works on Sports. Have each student 
create his or her own project. We suggest that you use the student’s name or section 
name in the project file (e.g. heather.sb3 or sports.sb3). 

3. When you are creating projects, designate one of the projects as the Master Project. 
Create this project on a computer that will be able to access all other computers when 
it comes time to import pages and sections from other projects. 

4. After all of the students have completed their sections, make sure they are accessible 
on the computer that has the Master Project using the suggestions below. 

 
Accessing Projects on the Master Computer 
Before importing, the computer with the Master Project must have access to all of the 
projects. Locate the heading that most closely describes your situation or call Tech 
Support for help. 

All projects are saved on a school network 
Windows Computers – When browsing for projects to import, click on the drop-down 
menu near the top of the Import from dialog and choose the network drive (if it is 
mapped) or My Network Places. 
Mac Computers – Connect to the school network before importing. When browsing for 
projects to import, click on the drop-down menu in the Import from dialog and choose the 
bottom option (usually <Username>’s Computer – Bob’s Computer, e.g.). The network 
drive should be inside the Volumes folder. 

Projects are saved on individual computers 
You will need to move the projects either to a network or to the hard drive computer with 
the Master Project. 

Network 
• For each project, locate the project folder in a My Computer/Windows Explorer 

window on a Windows computer or a Finder window on a Mac (if you are unsure 
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where the project is located, open Memories Builder and hold down the 
Ctrl+Alt+Shift keys and then hit the ‘F’ key). 

• Close Memories Builder. 
• Copy the project folder (not just the .sb3 file) to a location on the network to which 

you have full read/write access. 
• See the instructions for All projects are saved on a school network. 

Hard Drive (no network) 
• You will need to move the projects to the master computer by burning CDs or using 

an external hard drive. 
• For each project, locate the project folder in a My Computer/Windows Explorer 

window on a Windows computer or a Finder window on a Mac (if you are unsure 
where the project is located, open Memories Builder and hold down the 
Ctrl+Alt+Shift keys and then hit the ‘F’ key). 

• Close Memories Builder. 
• Burn the project folder (not just the .sb3 file) to a CD or copy it to the external hard 

drive. Then insert the CD into or connect the external drive to the Master computer. 
For help with burning a CD, call Tech Support (877-463-6924 ext. 23). 
 
Import Pages and Sections 
Before exporting the final project for submission, all pages that will be in the final 
presentation must be in a single project (the Master Project). Use the Import Pages and 
Sections function to bring all of the parts of the project together. If the section you are 
trying to import is a portrait section, see Import Portrait Section below. 
Note: Importing pages or sections that contain Hot Spot links to outside pages or sections may 
remove the Hot Spot’s link. Check and fix Hot Spot links as needed after importing. 

1. Open or create the master project.  
2. In the Contents window, choose a location for 

the page(s) or section(s) to import by selecting a 
section, page, or the Master Level.   
Note: Selecting a section will place the imported 
page(s) or section(s) first in the section. Selecting a 
page will place the imported page(s) or section(s) 
directly after the selected page. 

3. Choose Import Pages/Sections from the Insert 
menu. 

4. In the Import Pages and Sections dialog, click 
on the open folder icon and browse for the 
project folder which contains the page(s) or 
section(s) to import. Click on the project folder 
and then the Select Folder button. 
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5. The import window will show the sections and pages in the project. Select the first 
page or section to import. Click on the Show Preview box to display the selected page 
or section. 

6. Click Import when you are satisfied with your selection. The icon of the imported 
section or page will turn gray. Repeat as needed.  

7. Click Close when you have finished importing pages and sections. 
8. The imported page(s) or section(s) will now appear in the master project. Importing 

sections will also bring their background images and background music with them. 
9. Check any Hot Spots on imported pages that link to other project pages. 
10. (Optional) Save the project. 
 
Import Portrait Section 
Memories Builder only allows importing of complete portrait sections (individual pages 
are not available for import). When preparing Class Portraits, finish entire classes before 
importing them to another project, since it is not possible to combine portions of a single 
class from different projects. To import a class portrait section: 
1. Choose Import Portrait Section from the Insert menu. 
2. In the Import Portrait Section dialog box, click 

on the open folder icon, browse for the project 
that contains the class portrait section(s) to 
import. Click on the project folder and then the 
Select Folder button. 

3. The import window will now show the Class 
Portraits sections in the project. Click on the 
plus or arrow icon to show subsections and 
pages.  

4. Select the first section to import by clicking on 
it once. Click the Import button. 

5. Memories Builder will place the imported 
section as a subsection in Class Portraits. Repeat 
step 4 as needed. 

6. When finished, click the Close button. 
7. Imported sections include their background images and section objects. Drag the 

sections in the Contents window to reorder them as needed. 
 
After you have all the projects combined into one, you can spell-check, proof/lock, and 
export your project for submission. 
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Appendix C: Project Preferences 
 
The Memories Builder Preferences dialog is an interface for accessing functions and 
default settings that affect the entire project and the way that you use Memories Builder. 
 
To access Preferences, choose Preferences from the Edit menu. The following dialog 
will appear: 

 
 
a. Viewer – Choose the navigation bar that users will see when viewing the final 

product. Double-click to open folders and click to select and preview different 
options. 

b. Viewer Quality – Click the Best Quality button to choose a setting that creates 
higher quality pages in the final product. Click on More Pages to allow more total 
pages. The higher quality pages take about 1 MB per page, while the More Pages 
setting averages about half of that per page. 

c. Transition – A transition is an effect that happens between page changes. Choose the 
default transition for new sections from the drop-down menu. Check the Apply 
selected transition to all sections box to change all project transitions. 

d. Font – Choose the default font style options for new text boxes (see #2 on p. 26 for 
more information on font style options). 

e. Captions – Check the box on this tab enable auto captions. When auto captions are 
enabled, Memories Builder will include a text box with the image name every time 
you place an image on the page canvas. 

f. Shadow – Choose the default shadow settings for images, shapes, and text. There is 
also an option to add shadows to every object in the project (except portrait images). 

g. Grid – Choose Show Grid to display guide lines on the page canvas to help align 
objects. Choose Snap to Grid to have objects align to the nearest grid line when you 
move them. Use the Grid Size slider to determine how far apart the guide lines are. 
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Appendix D: Preparing Your Media Files 
 

Preparing Images 
 
Images are the real focus of a yearbook; students will spend most of their time looking at 
them. Therefore, you want your images to look as good as possible. The following 
recommendations will help you maintain a professional look throughout your project. 
 
Bringing Images into Your Computer 
Since Memories Builder supports a large number of image file formats (JPG, GIF, PNG, 
BMP, PSD, TIF, PIC, and PCT), there are a number of ways to save images to your 
computer. When importing images from a digital camera or photo disk, the default 
settings should work fine.  

Image Scanning – Recommended Settings 
Format:  JPG  
Quality:  High  
Resolution:  150 dpi (300 dpi if you will be using the same image in the print yearbook) 
 
Changing Image Settings 
Computer image files, like sound and video files, tend to be large and can quickly eat up 
hard drive space. If you are running out of room on your hard drive, change your images’ 
settings if you have them in uncompressed file formats (like BMP or PSD) or if you are 
planning to include a large number of images in your project. We recommend that you 
use file formats that compress the size of the image file (such as JPG or GIF).  

Image Editing Programs (Photoshop, etc.) – Recommended Save/Export Settings: 
File Format:  JPG (jpeg) 
Quality:   Medium to high (8-10 in Adobe Photoshop™) 
Resolution:   72 dpi* 
Size:    not much larger than 800 pixels wide by 600 pixels high** 
* Unlike images that you are using for a print yearbook, images that you will use in the CD supplement 

don’t require a high resolution; 72 dpi is usually sufficient. 
** Size settings are a balancing act. On the one hand, if your images are larger than necessary, you will be 

using extra hard drive space since larger images generate larger files. On the other hand, if you blow 
up a small image to fill a large area on a page, it will lose quality. Try to save images so that their 
dimensions are the same size or a bit larger than the area they will fill on the page. 

Other formats: 
See the documentation for your image-editing program for recommendations. 
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Portrait Preparation 
When planning the portrait section of your CD yearbook, the first step is to figure out 
how you will get the portrait images onto computer. There are three possibilities: 
• Your school photographer may have these photos on a CD-ROM.   
• The portraits could be on a digital camera. 
• You have hard copies of the images, and will need to scan them. 
 
Images on CD 
You will save time if you have access to a CD containing digital student photos. Most 
photo CDs store the pictures in JPEG format.  

Some photo CDs are set up for Macintosh computers and won’t have the file extensions 
(.jpg, for example).  
• Windows Computers: Download a program called A.F.5 Rename to run batch 

renaming. You can download this program from www.download.com (do a search on 
A.F.5 Rename).  

• Mac Computers: Call Technical Support for information about using the Mac utilities 
that are included on the Memories Builder CD. 

 
Digital Camera 
Getting images is a matter of plugging your digital camera into your computer, choosing 
the Import Portraits item from the Portraits menu in Memories Builder, selecting 
Individual Files, and browsing to your camera to find the images. If you can’t locate 
your camera in Memories Builder, copy the images to the hard drive using Windows 
Explorer (My Computer) or the Mac Finder. 
 
Scanning 
If you have to scan your photos, select color and 72 dpi. Save the images in JPEG format.  
Memories Builder recognizes certain naming conventions, and you will save yourself a 
lot of hassle when it comes time to edit portrait names if you use one of the following 
formats when choosing file names: 
LastName FirstName Initial (example: Smith_John_A.jpg) 
FirstName LastName Initial (example: John_Smith_A.jpg) 
 
Once you have access to the portraits on your machine, you are ready to import them into 
the program. See Class Portraits on p. 43 for more information. 

http://www.download.com/
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Preparing Audio Files 
Audio files can make your yearbook much more appealing.  

Ways to Use Audio in Memories Builder: 
• Background Music 
• Page Narration 
• Hot Spot Link 
 
This guide will explain how to prepare your files and the different ways of using them in 
your yearbook. 
 
Software 
In order to prepare your audio for use, you will need audio editing software. There are 
many programs available, ranging in price and features from the free Audacity to 
Cakewalk SONAR (a full suite of digital audio editing tools and effects).  

Free Audio Software: 
Audacity (recorder/editor)  audacity.sourceforge.net 
CDex (utility for transferring music from a CD)  www.cdex.n3.net 
 
For other recommendations, call Technical Support at 877-463-6924. 
 
Optimizing Audio 
Audio editing programs allow you to change a number of settings that will affect the 
sound quality and size of your audio files (the higher the sound quality, the larger the file 
size). Audio files can be very large. It’s best to make your files as small as possible, 
without compromising too much sound quality, to save space and speed up your project.  
 
MP3 Format 
This popular format is extremely useful for reducing file size while maintaining 
acceptable standards of quality. We recommend this format for full-length songs. If your 
sound-editing program doesn’t have an mp3 encoder, save your files on your hard drive 
as WAV or AIFF files, and then download CDex (see above) to convert the files to mp3 
format. Once they’re in mp3 format, you can bring them into the project. We recommend 
the following settings for mp3 files: 
• 160 kbps Bit Rate (128 kbps is fine for speech) 
• Stereo Channel Setting 
 
WAV and AIFF Formats 
WAV is the standard Windows audio file format, and AIFF is the standard for Mac 
computers. We recommend these formats for loops. After recording speech or music, it’s 

http://audacity.sourceforge.net/
http://www.cdex.n3.net/
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always a good idea to save a copy of the file in WAV format or AIFF format, depending 
on your platform. 
 
For speech, we recommend the following settings: 
• 22,050 Hz Sample Rate (also called Sampling Frequency) 
• 16 Bit Resolution 
• Mono Channel Setting 
 
For music, we recommend the following settings: 
• 22,050 Hz Sample Rate (also called Sampling Frequency) 
• 16 Bit Resolution 
• Stereo Channel Setting 
 
We also recommend that you normalize your audio files. This will set them to more even 
volume levels (so that one file is not much louder or softer than another). Most audio 
editing programs have a normalize function. CDex provides an option for normalizing 
files when you are recording from a CD or converting files from one format to another. If 
the normalize function has settings, choose 100% or 0.0dB.  
 
Using Audio in Your Project 
After you have prepared your audio files, you are ready to bring them into the project. 
There are three ways that you can use audio files. Consult the following descriptions to 
help you decide how to best use your audio: 
• Background Audio – Plays continuously as viewers browse the project. 
• Page Narration – When a viewer navigates to a page with Page Narration, Memories 

Builder interrupts the background music to play the narration file. Afterwards the 
background music will resume. 

• Audio File Hot Spot – Makes an area of the canvas active (a Hot Spot). When 
viewers click on the Hot Spot, Memories Builder interrupts the background music to 
play the audio file. After the audio file is finished playing, background music 
resumes. 

 
How you add the audio file into your Memories Builder project will depend on how you 
decide to use the file in your project. Consult the instructions below: 

Background Audio 
1. Background audio is assigned by section. Locate the section to which you’d like to 

add background audio in the Contents window and double click on it. 
2. In the Section Properties dialog, click on the Memories Builder Music Library 

icon or the open folder icon next to the Background Audio field. 
3. Browse for your audio file in the File Preview dialog and double click on it. 
4. The file will now be assigned as background audio. Click on OK in the Section 

Properties dialog. 
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Page Narration 
1. Page narration is assigned by page. Locate the page to which you’d like to add page 

narration in the Contents window, and double click on it. 
2. Click on the open folder icon next to the Page Narration field. 
3. Browse for your audio file in the File Preview dialog and double click on it. 
4. You may also record your own page narration if you have a microphone for your 

computer. Click on the Record button. Wait for the prompt to begin recording and 
the time counter that shows the length of the recording and then speak into the 
microphone. When you have finished, click Stop. Go into preview (click on the eye 
icon on the toolbar) and check the page narration. If necessary, record again. 

5. The file will now be assigned as page narration. Click on OK in the Page Properties 
dialog. 

Audio File Hot Spot 

1. Click on the Hot Spot icon  on the Main Toolbar. 
2. In the Link Hotspot To dialog, click on the Audio radio button. 
3. Click on the open folder icon next to the Audio field. 
4. Browse for your audio file in the File Preview dialog and double click on it. 
5. The file will now be assigned as a Hot Spot. (You may preview it with the Play 

button or remove it with the Clear button.) Click on OK. 
6. Select an area for the Hot Spot by clicking and holding the mouse button down on the 

canvas, and then dragging to open up a Hot Spot area. When you release the mouse 
button, Memories Builder creates the Hot Spot. 

7. The Hot Spot will appear as a red rectangle outline on the canvas. 
 
For your convenience, Memories Builder provides a few royalty-free audio selections 
that you can use. Look for the Memories Builder Music Library icon.  
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Yearbook Interactive CD 
Video Overview 

 
 
Three steps are involved in creating videos for your CD yearbook:  Importing, Editing, and Exporting. 

Importing: 
Video can be imported to your computer in one of two ways: 

Analog Video Capture  or  Digital Video (DV) Capture 
 
 
 
 
 

 (RCA) Analog Cables     Analog Capture Card (PCI)      DV Cable  DV Card (PCI)  
 

You may need to purchase an analog video capture card ($90 to $350) or a DV capture card ($29 to $199) if your 
computer doesn’t have one. Many new Apple™ PowerMacs, iMacs, PowerBooks, and iBooks include built in DV 
capture called FireWire™.  Some new PC computers include DV capture called iLink™ or IEEE1394.  If you have a 
computer with DV ports but only have video on VHS cassettes (analog video) you will need a media converter ($249-
$399) or an analog capture card.  Call Yearbook Interactive for more information (877-463-6924 ext. 23). Some DV 
camcorders have video inputs that convert analog to digital (basically a media converter built in). 
 

Editing: 
Editing consists of taking raw video and cutting out extra footage, boring scenes etc., or adding special effects such as 
slow motion or fades.  Some popular programs with varying features and cost are listed below: 
iMovie™ (included with OS X, Mac only) 
Final Cut Pro™ ($499 Educational Price, Mac only) 
Adobe Premiere or Premiere Elements ($599 or $100 PC & Mac) 
 

Exporting: 
It is important that your video not only looks good, but also utilizes a small amount of space.  Our recommended 
settings are: 
 
File Type:  QuickTime “.mov”* 
Video Settings: Audio Settings: 
     Frame Size: 320x240      Compressor: uncompressed 
     Compressor: MPEG-4      Sample Rate: 22.050 kHz 
     Quality: High      Size: 16bit 
     Frame Rate: 15fps (30fps sports)      Channels: Mono 
     Key Frames Every: 24   
     Limit Data Rate: between 720 and 1200 kbits/sec  
*Memories Builder also supports AVI with Cinepak codec and MPEG using Multi-Media Settings. 
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Appendix E: Troubleshooting 
 
Memories Builder opened up blank (no project is showing) or prompted me to create a new 
project, even though I have already created a project. 

There are a number of things that could have caused this, including: 

Changing computers or logging on as a different user 
Memories Builder will not automatically open your most recent project if you change to a 
different computer or if you log in as a different user. 
• Cancel the New Project dialog (if prompted), choose Open Project, browse to your 

project, click on the project folder (not the project file), and click on the Select Project 
button. 

• If you need to open your project, but are not sure where you saved it, do a search on the 
hard drive for files with ‘.sb3’ (without the quotes) in the filename. 

Lost user preferences file 
Memories Builder keeps track of your most recent project through a preferences file. 
Occasionally, this file may get lost for unknown reasons. 
• Cancel the New Project dialog (if prompted), choose Open Project, browse to your 

project, click on the project folder (not the project file), and click on the Select Project 
button. 

• If you need to open your project, but are not sure where you saved it, do a search on the 
hard drive for files with ‘.sb3’ (without the quotes) in the filename. 

Corrupt or lost project 
If you received a message that there is a problem with the project and you need to call 
Technical Support, do so immediately (877-463-6924 ext. 23). Also, call Tech Support if the 
project folder is missing or parts of the project folder (such as the .sb3 file) are missing or if 
project pages come up with error messages or blue and yellow boxes where images and text 
should be.  

No network connection or not logged in 
If your project is saved on a network, ensure that you are logged into the network and that 
your network connection is working. 

 
It’s time to combine our projects, and I can’t remember where we put them all. 

Open projects on their original computers, hold down the Ctrl+Alt+Shift keys together and 
hit the ‘F’ key. This will display the location of the project file. 

 
Our project is too big. 

This is typically caused by video files, but there are a number of possible causes. 

Figuring Out What Is Taking Up Space 
Choose Compare to Plan from the Modify menu (even if you did not create a project plan). 
Look at the right column (Actual). Near the bottom it will tell you how much space you are 
using in each category (except pages). Pages take about 1 MB each. 
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If video and audio are taking up a lot of space, you should compress or recompress the video 
and audio files. If you are unsure of how to do this, call Tech Support at 877-463-6924 
ext.23. See our recommended settings on p. 86.  
Images – Resolution and Space 
The image resolution of your scanned images will not make any difference, since Memories 
Builder adjusts the image resolution before adding an image to a page (or calculating how 
much space it uses). 

Pages 
If you are planning to have more than 400 or 500 pages, you should probably use the lower 
quality setting for pages.  

The disadvantage of the lower quality pages is that text will sometimes appear blurry, 
especially if you are using red or green text or a text color that is similar to the color of the 
section background. 

Page/Viewer Quality 
Important: Only make this change if you run out of room because of pages. 

To change the text quality setting, choose Preferences from the Edit menu.  
Click on the Viewer Quality tab. 
Click on the More Pages button (notice how the red text is a little blurry in the example 
image). 

If you are worried about the quality of the pages or if you end up using fewer than 400-500 
pages, you can always change this setting back to Best Quality. 

 
If you have any other questions about project size, call Tech Support. 

 
We locked all of our pages, but Memories Builder says we still have pages or sections that are 
unlocked. 

Hold down the Ctrl key (Apple key on the Mac) and then hit the Page Down key. Memories 
Builder will search the project and select the first unlocked page. 

 
Do we have to lock all of the pages and sections in our project? 

Yes. This ensures that there will not be problems with the final presentation (since Memories 
Builder checks pages for errors are you lock them) and also gives you a final chance to 
approve the contents of the project. The Export for Submission process will not work until 
all pages and sections are locked. 

 
We finished the Finalize Project steps, but we don’t know where the submission file is. 

Search the computer for a file named SendToYBI.ybz. Burn that file to CD. 
 
MB says that the name I am choosing for my project already exists. However, this is the first 
project I have created. 

This is most likely a permissions issue. Call Tech Support (877) 463-6924 ext. 23. 
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Appendix F: Memories Builder 7.0 License Agreement 
 
Note: This User’s Guide contains this License Agreement as a courtesy. It is a copy of the agreement that 
you approved when you installed Memories Builder 7.0.  
 
Thank you for your interest in Memories Builder 7.0.  In order to proceed with the installation of 
this software program, you must review and agree to the terms of this License Agreement.   This 
Agreement describes the licensed uses of the Memories Builder 7.0 software, and its installation.  
By indicating your agreement to this license, you have not obligated yourself or your school to 
purchase any number of CDs for your school yearbook.    
 
Important  — clicking Next indicates agreement to this license. 
You should carefully read the following terms and conditions before opening, installing, or 
using the Memories Builder 7.0 software package.  The downloading, opening, installation 
or use of the Memories Builder 7.0 software package shall in all cases be construed to mean 
that you accept these terms and conditions and understand that they will be legally binding 
on you, your school as well as any end user. If you do not agree with these terms and 
conditions, or do not want them to be binding on you, you should delete the Memories 
Builder 7.0 software package from any storage medium that it is installed on.  
 

Ownership  
You acknowledge and agree that StoryRock, Inc., doing business as Yearbook Interactive 
("Licensor") is the owner of all right, title and interest in and to the software, whether 
downloaded or otherwise obtained, and the computer programs contained therein in machine 
readable object code form as well as the accompanying user documentation along with all 
subsequent copies thereof, regardless of the media or form in which they may exist (collectively 
the "Software"). The Software, and any photographs or images included in the Software, is 
protected by United States copyright laws and international treaty provisions, and this License 
Agreement does not convey to you any interest in or to the Software, digital content, or any 
accompanying printed materials, but only a limited right of use and limited right of reproduction 
which is revocable in accordance with the terms of this License Agreement.  
 

License  
1. Grant of License. Licensor hereby grants and you accept a nonexclusive license to use the 

Software in accordance with the terms of this Agreement.  
2. All photographs and imagery contained within the Memories Builder 7.0 software are 

copyrighted by the credited photographer or photo source. The Memories Builder 7.0 images 
cannot be used outside of the Memories Builder 7.0 software.  Exporting the Memories 
Builder 7.0 images into ANY OTHER SOFTWARE product is expressly prohibited. No 
other distribution of the Memories Builder 7.0 images is authorized. 

3. Reservation of Rights. All rights not expressly granted to you by this License Agreement are 
hereby reserved by Licensor.  

4. No Disassembly. It is understood and agreed that you shall not copy the program into any 
machine-readable or printed form except for archival or for backup purposes in accordance 
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with the terms of this Agreement, nor shall you reverse engineer, decompile, disassemble, 
translate, merge into another computer program, obscure or remove Licensor's copyright 
notice or otherwise modify the Software.  

5. No Rental. You may not rent or lease the Software or any right or license granted under this 
Agreement.  

6. Transfer of Software. You shall not sublicense, assign, or transfer the license or the Software 
or any rights under this Agreement without the prior written consent of Licensor. Any 
attempt otherwise to sublicense, assign, or transfer any of the rights, duties, or obligations 
hereunder is void.  

7. Updates and New Versions. In the event that updates or new versions of the Software are 
developed, Licensor may, at its discretion, make such updates and new versions available to 
you upon payment of any required fees, if any, and return of the original Software to 
Licensor, if demanded. If the Software is updated and made available to you, you may use 
the updated or new versions of the Software in accordance with the terms and conditions of 
this License Agreement.  

8. Term and Termination. This License Agreement is effective upon your opening the Software 
package, or its initial use if downloaded, and shall continue for a period of five (5) years 
unless terminated earlier in accordance with the terms herein. You may terminate this 
License Agreement at any time by returning the Software and all copies thereof and extracts 
there from to Licensor.  

9. Dual Media. You may receive the Software in more than one storage medium. You may use 
the medium that is appropriate for your computer(s). You may not use, copy, transmit, lease, 
rent, sell, assign or otherwise transfer any medium containing the Software to another user.  
For the purposes of this Agreement, a licensed and accredited school shall be considered a 
single user, and such school shall be entitled to install one copy of the Software on as many 
computers within the school as are necessary or desirable to complete a yearbook or multiple 
supplements for that single user school.  

10. Limited Warranty. Licensor warrants the disks or medium on which the Software program is 
furnished to be free from defects in materials and workmanship under normal use for a 
period of ninety (90) days from the date of delivery to Licensee, as evidenced by your 
receipt. You shall assume responsibility for the selection of the Software and for the 
installation, use, and results obtained from the Software. The entire risk as to the quality and 
performance of the Software is with you.  
The program is provided "as is" without warranty of any kind, either express or 
implied, including, but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Licensor does not warrant that the functions contained 
in the software will meet your requirements or that the operation of the software will be 
uninterrupted or error free. 
Some states do not allow the exclusion of implied warranties, so the above exclusion may not 
apply to you. This warranty gives you specific legal rights, and you may also have other 
rights that vary from state to state.  

11. Final Submissions.  The only use of the Software licensed under this Agreement requires the 
user to use the Software's routines to assemble and compile a multimedia yearbook 
supplement project(s) for a single school user.  Such projects are only to be used for 
submission back to the Licensor for replication or duplication.  A separate charge per disc is 
made for the replication or duplication of any project completed using the Software. You, the 
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school user, assume the entire responsibility for the content submitted to StoryRock, Inc., and 
specifically warrant that: 
a) You have reviewed the entire content of the multimedia yearbook supplement project 

submitted to StoryRock, including all images, text, movies, files, and links prior to 
submission, and that  

b) You have approved all such content as un-offensive, accurate, and appropriate for 
distribution to the audience for which it is intended, and that  

c) You have obtained appropriate permission to use copyrighted materials, if included, 
wherever necessary or appropriate.  

d) You acknowledge that all materials submitted to StoryRock become the property of 
StoryRock for the purpose of replication or reproduction.  StoryRock may at its sole 
discretion make additional copies of complete projects, or any file, picture, video, sound, 
link, or the like contained thereon for distribution as sample projects. 

Neither StoryRock nor any of their affiliates, representatives, etc. assume any liability 
of any kind for the content compiled using the software, whether submitted to it for 
replication or duplication, or not.  

12. Remedies. Licensor's entire liability and your exclusive remedy shall be: The replacement of 
any Software disk or medium not meeting Licensor's "Limited Warranty" above and that is 
returned to Licensor with a copy of your receipt; or if Licensor is unable to deliver a 
replacement copy that is free of defects in materials or workmanship, you may terminate this 
Agreement by returning the Software product for a full refund of the purchase price, if any.  

13. Limitations of Liability. IN NO EVENT WILL LICENSOR BE LIABLE FOR ANY 
DAMAGES, INCLUDING BUT NOT LIMITED TO, LOST PROFITS, LOST SAVINGS, 
LOST TIME, LOST FILES OR OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE 
EVEN IF LICENSOR OR ITS EMPLOYEES OR REPRESENTATIVES HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY 
ANY OTHER PARTY.  
In any event, Licensor's cumulative liability to you or any other third party for any loss or 
damages resulting from any claims, demands, or actions arising out of or relating to this 
Agreement shall not exceed the license fee paid by you to Licensor for the license and use of 
this Software.  

14. Jurisdiction and Disputes. This Agreement and the Limited Warranty provide for herein shall 
be governed by the laws of Utah. All disputes hereunder shall be resolved in the applicable 
state or federal courts of Utah, and the parties consent to the jurisdiction and venue therein. 
The application of the United Nations Convention on Contracts for the International Sale of 
Goods is hereby expressly waived and excluded.  

15. U.S. Government Restricted Rights. The Software and documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and 
Computer software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software - Restricted Rights and 48 CFR 52.227-19, as applicable. 
Manufacturer is StoryRock, Inc. 474 Bearcat Drive, Salt Lake City, UT 84115. 

16. Integration. This Agreement constitutes the entire understanding of the parties relating to the 
license of the Software, and revokes and supersedes all prior agreements, oral or written, 
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between the Licensor and you, and is intended as a final expression of the Agreement. It shall 
not be modified or amended except in a writing signed by an officer of StoryRock, Inc. 
specifically referring to this Agreement. This Agreement shall take precedence over any 
other documents that may be in conflict therewith.  

 

Questions  
All questions concerning this Agreement may be directed to manufacturer: 

StoryRock, Inc.  
474 Bearcat Drive 
SLC, UT 84115 
or to: 
Service@StoryRock.com 

 
You hereby acknowledge that you have read these software program license terms and 
conditions, understand them and agree to be bound by them.  
 

Memories Builder 7.0  © 2006  All rights reserved. 

mailto:service@storyrock.com
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Appendix G: Completion Checklist 
Project Completion Checklist – Use this form to ensure that your project is ready to send. 
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The Before-You-Send-in-Your-Project Check List 
 
Memories Builder 7 includes a Finalize Project process that assists you in ensuring the quality and on-
time delivery of your yearbook. The checkboxes below will help you follow the process. 

1.  Preview Your Project 
Click on the  icon on the Toolbar or choose Preview from the File menu. You should carefully 
examine the project at least one time for each of the items below. 

 General Issues 
 Ensure look and feel is as desired. 
 Review the flow of the project, including the organization of the sections and pages. 
 Ensure that all desired sections and pages exist and are enabled as expected. 
 Unwanted pages have been disabled or deleted.  

 Background Audio 
 Background audio is present in desired sections and plays as expected. 
 Background music loops where desired. 
 Background music is not copyrighted or written permission has been obtained to use copyrighted 

music. (All music provided by YBI is royalty-free music.) 
Note: If a long delay occurs before the background audio starts, it may indicate the audio file size is 

too large.  Avoid using audio clips larger than 5MB in size.  To reduce the size of music files, try 
looping them into short clips to save on space and/or convert .wav and .aiff to the .mp3 format. 

 Narration auto-plays on the appropriate pages and is audible. 
 Audio clips and narration do not contain any offensive or questionable material or sounds. 

 Text 
 Text is not cut off or truncated in any of the text boxes. 
 All desired text content is present and laid out as expected. 
 Text contains no offensive language, terms, or ideas. 
 Spelling has been verified by running the Spell Checker and by reading through the text. Proper 

names have also been verified. 
 Text colors have adequate contrast to be seen over background or other images. 

 Video 
 Video clips are present and play as expected. 
 Video clips are appropriate. (No offensive material.) 
 Ensure that video clips have been saved in a compressed format (e.g. QuickTime movie format 

with MPEG-4 compression.). For more information, see the Video Guide on the Yearbook 
Interactive Web site (www.yearbookinteractive.com/support.html).  

Note: We recommend that you test your video clips on a few different computers to ensure that they 
will play properly. 

 Check Class Portrait Sections 
 All Class Portraits are present. 
 Names associated with each portrait are correct and are spelled correctly. 
 Clicking on portrait images brings up a larger photo with associated information. 
 Audio/Video clips, if included, are present and contain no offensive material. 

http://www.yearbookinteractive.com/support.html
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 Written permission has been obtained for the use of portrait images. 

2.  Spell Check Your Project 
 Run the Spell Checker by clicking on the  icon. Words that are not currently in the Memories 

Builder Spell Check dictionary will be displayed.  
Note: The Spell Checker identifies a word as a string of text with a space on both sides. In cases 

where a single word has multiple colors or styles, the Spell Checker will “read” the text between 
spaces and style or color changes as a word and display them as misspelled words.  

3.  Proof Your Project 
 Check the Master Overlay and the sections first. (They must be locked in order to lock pages.) 
 Click on the lock icon  just above the Contents window. 
 As you lock pages and sections, Memories Builder will indicate if there are any problems. Fix the 

items shown on the error list. Lock the Master Level, all sections, and all pages. 
 For each page, check for the following: 

 All desired objects are present and display as intended. 
 There are no hidden images, Hot Spots, or text. 
 Content is not offensive, suggestive, or disrespectful of any group or individual. 
 Video and audio links play as expected and are appropriate. 
 Hot Spots do not launch or link to offensive or questionable materials, nor do they criticize, 

demean, or disrespect any persons or groups directly or indirectly. 

4.  Finalize Project (formerly Compile) 
Yearbook Interactive requires your project to be exported to a special format in order to be submitted for 
final replication. This is done from the Export for Submission option under the Finalize Project menu.  
The output of this process will be a compressed file named SendToYBI.ybz. The compiled project does not 
replace your original project or any of its files.  

 Before you compile your project, backup your project files to another location (either on your 
hard drive or by burning to a CD). Choose Backup Project from the File menu and choose a save 
location. It is also a good idea to burn the project folder to a CD as an additional backup. 

 To compile, choose Export for Submission from the Finalize Project menu (everything must be 
locked before exporting). 

 Select a location to save the compressed file. (You can save it to any location on the computer, 
such as the Desktop. The default location is the Memories Builder 7 folder.) 

 Compiling your project can take quite a while. Be patient. You must wait for the message that 
indicates your project has successfully compiled. Your project will not compile if: 
a. You have not locked all pages and sections. 
b. There are errors in the project. Memories Builder will inform you of any problems. 

Note:  After you compile you still are able to make changes to your project by unlocking pages.  
However, if you make any changes, be sure to re-compile and overwrite the previous file. 

 Burn the “SendToYBI.ybz” file to a CD to submit to Yearbook Interactive. After burning the CD, 
take it to another computer and copy the file to the hard drive to ensure that the burn worked.  

 Make a copy of the CD to keep as a backup. 

5.  Submit Your Project to Yearbook Interactive 
A Final Submission Form will be required to submit your project. For more assistance, contact a YBI 
Customer Service Representative at 1-877-463-6924. Projects must be submitted by mail. Please plan 
adequate time to send your project to Yearbook Interactive. 
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